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CHAPTER 1

INntroduction

Welcome to Parallels Desktop for Mac Enterprise Edition. Built on the world’s best-selling, top-
rated, most-trusted solution for running Windows applications on the Mac, Parallels Desktop
Enterprise Edition adds the capabilities that help IT administrators and purchasing agents save time
and money.

In This Chapter

Enterprise FEAtUreS OVEIVIEW .........uuiiiiiiiiiieeiiie et 6

Enterprise Features Overview

With Parallels Desktop for Mac, your Mac users can seamlessly run both Windows and OS X
applications side-by-side with speed, control and confidence. Business users can experience as
much or as little Windows as they want. Multiple view modes make it possible for users to
customize the level of integration between Mac and Windows without compromising performance.
Best of all, IT can lock down, secure, and control the settings that matter most.

Parallels Desktop Enterprise Edition Features Highlights

« Simplified license management.

« Maintain corporate compliance with restricted virtual machines.

« Set an expiration date for a virtual machine.

« Run virtual machines in the background (“head-less” mode).

« Mass deployment of virtual machines and management through Microsoft SCCM.

« Business-level support including 24/7 phone and email support options.

Parallels Desktop Enterprise Edition Feature Matrix

See how Parallels Desktop Enterprise Edition compares to Parallels Desktop standard edition.

Enterprise Standard

Feature Edition Edition

World’s most powerful, best-performing solution for running Windows
applications on a Mac



Introduction

Full support for OS X 10.9 Mavericks, 10.10 Yosemite and Windows 8.1

Coherence view mode allows to run Windows applications on a Mac, just
like if they were native Mac applications

In-product downloads of security and anti-virus trial software for Windows
and Mac

Licensing and Support

License management via Licensing Portal (coming Fall 2014)
Simple deployment with unified volume license key

Business class support with 24/7 priority phone and email access
Annual subscription includes free upgrades

Customizable in-product "Request Support" option

Removed in-product notifications and third-party offerings

Configurable software update policy and local update server options
Security

Restrict end-users from changing virtual machine settings
Restrict end-users from creating new virtual machines
Create expiring virtual machines

Enforce USB device policies

Configurable policies via SCCM and Parallels Mac Management
Advanced

Run virtual machines in "head-less" mode

Support for mass-deployment of virtual machines

Ability to assign Asset ID to a virtual machine BIOS

NetBoot and FileVault 2 support in Mac X OS virtual machines
Configurable boot delay for a virtual machine

Customizable Parallels Control Center user interface



CHAPTER 2

Parallels Business Account and License
Management

Parallels Business Account provides functionality to help you better manage your Parallels Desktop
Enterprise Edition licenses.

With Parallels Business Account you can:

« Register you Parallels Desktop Enterprise Edition license keys.

« Automatically add licensed computer information to the account during Parallels Desktop
Enterprise Edition deployment.

« See the detailed license key information including the number of licenses it provides, the
number of licenses used and remaining, and the license key expiration date.

« See the list of computers with active licenses.

« Export the computer list to a CSV file.

« Deactivate a license on a computer.

« Blacklist a computer.

« Download Parallels Desktop Enterprise Edition documentation and the latest build.

« Contact Parallels Support.

The chapter describes how to register a Parallels Business Account, add a license key to it, and
then manage licensed computers in your organization.

In This Chapter

Registering a Parallels Business Account and Adding License Keys ..........ccccvvvvvennnn. 8
Deploying Parallels Desktop Enterprise Edition on Macs......cooooeevvvviiiiiiiiiiiieeiiiiiiiiiens 10
Managing Mac Computers Using a Parallels Business ACCOUNt.............ccvvvvvvvvvvennn., 10

Registering a Parallels Business Account and
Adding License Keys

To register a Parallels Business Account, enter the following URL into your Web browser:

https://account.parallels.com/#/register ba
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The URL opens the Business Account registration page:

|| Parallels

Business Account

Administrator

Company

By registering | agree to the Parallels Terms of Use.

Use the page to provide information about yourself and your company and click Register.

Once the account is registered, you will see the following page.

|| Parallels Paralels Demo

Get Started

Select an action to get started

||Paraliels
Parallels Access for Business Parallels Desktop for Mac
Purchase and manage licenses Enterprise Edition

Manage users
Manage users computers
Work with your computers

Manage license keys

r
e
.
o
3
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English
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Click the Manage license keys link located in the Parallels Desktop for Mac Enterprise Edition
section. On the page that opens, click the Add License Key tab.

I I Pal'a“els Parallels Desktop Enterprise

License Keys Add License Key

Parallels Desktop 10 for Mac Enterprise Edition

Parallels Desktop Enterprise Edition [T Administrators Guide PDF

Download Parallels Desktop 10 for Mac

4
]
T

Enter your license key in the box provided and then click the Add License Key button. The license
information will appear on the License Keys tab page. If you are not redirected to the page
automatically, click the License Keys tab.

Deploying Parallels Desktop Enterprise Edition on
Macs

After you register your Parallels Business Account and add one or more Parallels Desktop
Enterprise Edition license keys to it, you can deploy Parallels Desktop Enterprise Edition on Macs in
your organization. Please read the Mass Deployment of Parallels Desktop and Virtual Machines
section (p. 39) to learn how to do it. Once Parallels Desktop Enterprise is deployed on a Mac, the
Mac information will be automatically added to your Parallels Business Account. The following
section describes how you can manage your Macs using your Parallels Business Account.

Managing Mac Computers Using a Parallels
Business Account

This section describes how to use your Parallels Business Account to manage licensed Mac
computers in your organization.
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Signing In and Viewing License Key and Computer Information

If you are not currently signed in to your Parallels Business Account, please do so by entering to
following URL into your web browser:

https://account.parallels.com

The URL opens the Sign In page.

|| Parallels

Sign In Register

Forgot password?

License Agresment | Terms of Uise Privacy Policy EE  English

Enter your Parallels Business Account email address and password and click Sign In.You will see
your Parallels Business Account page:

I I Parallels Parallels Desktop Enterprise

All License Keys / HZNH57-KOAWSG-M23B49-5RSVK7-BC7TMDR

Licenses: 100 (used: 1; remaining: 99) Expires on: 2/7/2015

o 7 Actions

Hostname + Username Serial Number MAC Addresses

alev-MBP-Retina.local  alev,Guest C02J3GF2DKQ1 B8:F6:B1:19:E4:23,32:00:14:E6:5A:80,32:00: 14:E€

| >

<1>

Items per page: 10, 25, 50,100, 200

d
=
I

English

The License Keys tab page contains your license key information and the list of licensed
computers. You may need to scroll the list horizontally to see the complete computer information.
Please read the following sections to learn how to work with licensed computers using your
Parallels Business Account.

11
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Deactivating a License

To deactivate a license on a Mac computer:

1 Make sure you are on the License Keys tab page.
2 Inthe computer list, select the computer on which you want to deactivate the license.

3 Click the Actions drop-down menu and then click Deactivate.

I I Parallels Parallels Desktop Enterprise

License Keys

Al License Keys / HZNH57-KOAWSG-M23B49-5RSVK7-BC7MDR
Licenses: 100 (used: 1; remaining: 99) Expires on: 2/7/2015

Selected devices: 1

Hostname v Usermame Serial Number MAC Addresses Export all to a CSV i

Add to the blacklist
alev-MBP-Retinalocal  alev,Guest CO2J3GF2DKQ1  BB:F6:B1:19:E4:23,32:00:14:E6:5A o fhe e

Deactivate

<1 >

Items per page: 10, 25, 50, 100, 200

ﬁ
o
(]

Note: Parallels Desktop Enterprise Edition will continue to run on the affected computer until the
computer checks in with the licensing server. This could be anywhere from a few minutes to seven days.
If you want to deactivate the license on a computer immediately, you can log in to it and run the following
command in Terminal:

prlsrvctl deactivate-license

After the license is deactivated, it goes back to the license key pool and can be used to activate
Parallels Desktop Enterprise Edition on a different (or the same) computer. You can monitor the
available licenses for a given license key at the top of the License Keys tab page.

Blacklisting a Computer

If you want to deactivate a given license key on a computer without the possibility of re-activating it
later, you can add it to the blacklist. Please note that Parallels Desktop Enterprise Edition will
continue to run on the affected computer until the computer checks in with the licensing server.
This could be anywhere from a few minutes to seven days.

To blacklist a computer:

1 On the License Keys tab page, select the computer that you want to blacklist.

12
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2 Click the Actions drop-down menu and then click Add to blacklist.

|| Parallels Paralels Desktop Enterprise

License Keys

All License Keys / HZNH57-KOAWSG-M23B49-5RSVKT7-BC7TMDR

Licenses: 100 (used: 1: remaining: 99) Expires on: 2/7/2015
o 7 Selected devices: 1
Hostname + Username Serial Number MAC Addresses Export all to a CSV file

Add to the blacklist
alev-MBP-Retinalocal  alev,Guest CO2J3GF2DKQ1  BB:F6:B1:19:E4:23,32:00:14:E6:5A] o e

Deactivate

<1

ltems per page: 10, 25, 50, 100, 200

c
>
r
o
]

English

To view the list of blacklisted computers, click the Blacklisted Computers tab. To remove a
computer from the list, select it and then click Remove from blacklist in the Actions drop-down
menu.

| | Parallels e e

Blacklisted Computers

Blacklisted Computers: 1

%) & Selected devices: 1
Hostname v Username Serial Number MAC Addresses Remove from the blacklist
alev-MBP-Retina.local alev,Guest C02J3GF2DKQ1 B8:F6:B1:19:E4:23,32:00: 14:E6:5A:80,32:00:14:E€
] | 3
<1 >

Items per page: 10, 25, 50, 100, 200

=
(]
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Exporting Computer Information to a CSV File

To export the complete computer information table to a CSV file, click the Actions drop-down
menu and select Export all to a SCV file.

| | Parallels Parallels Desktop Enterprise

License Keys

All License Keys / HZNH57-KOAWSG-M23B849-5RSVK7-BCTMDR

Licenses: 100 (used: 1; remaining: 99) Expires on: 2/7/2015
(]
Hostname v Username Serial Number MAC Addresses Export all to a CSV file
alev-MBP-Retina.local  alev,Guest C02J3GF2DKQ1 B8:F6:B1:19:E4:23,32:00:14:E6:5A;
] |
<1>

ltems per page: 10, 25, 50, 100, 200

o
o
]

English
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Documentation and Support

The Support tab page provides download links to the latest build of Parallels Desktop Enterprise
Edition and the documentation. The page also provides Parallels contact information that you can
use to talk to or email with Parallels Support.

|| Parallels

|‘E Phone Support Hotline: (§:A Slype Support More Support Options:
Toll-free: +1 888-811-2488 ) Clickto Cell Visit Support Page
International: +1 703-579-0156 B Email Support

Documentation

Parallels Desktop Enterprise for IT Administrators POF

Parellels Desktop User's Guide FDF

Readme for Parallels Deskiop RTF | FOF

Getting Started With Parallels Deskiop FDF

Advanced documentation

Parallels Python AP| Reference ZIP
Parallels C AP| Aeference cHm | zP | PoF
Parallels Virtualization SDK Programmer's Guide CHM | | | FDF
L i = =



CHAPTER 3

Parallels Desktop Enterprise Edition
Features

This chapter explains how to use the advanced features of Parallels Desktop Enterprise Edition.

In This Chapter

Setting Asset Tag in Virtual Maching BIOS ... 16
Customizing Parallels Desktop Control Center User Interface .........ccocovvvvvvivvninninnnnns 17
Protecting Virtual Machine Configuration ..............cuvvviiiiiiiiiiiiiiiiiveeee 18
Locking Virtual Maching on SUSPENd ... 20
Encrypted Virtual MachiNgS ...........uuiiiiii e e 20
Running Virtual Machines in the Background (head-less mode) ..........cccccvvvvvvvvinnnnn. 22
Configuring Expiring Virtual MacChing..............uuuiiiiiiiiiiiiiiiiiiiiiiiieeeeeeeeieeeeeeeeeeees 27
Resetting Guest OS USEr PaSSWOIT ........viiiiiiiiiiiiiiiiiieeee e 28
Creating LINKEA ClONES .....iiiiiiiiiiii ettt 29
NetBoot Support for OS X Virtual MaChingS.......ceivviiiiiiiiiiiiii e, 31
Setting Up Local Update SEIVEL ........uueiiiiiiiiiaiaaenanennsnesennnnennnnnnnne 31
Customizing Request SUPPOIT OptiON ....uuuiiuiiiiiiiiiiiiiiiiiiiiiiiiiiiiae. 36
Participating in Customer Experience Program ... 37
Parallels Desktop License RENEWal............cooovviiiiiiii 37

Setting Asset Tag in Virtual Machine BIOS

Asset tags help identify, control, and track computer assets in the organization. Parallels Desktop
Enterprise Edition provides the ability to set an asset tag in the virtual machine BIOS, which can
then be read using the standard tools of the guest operating system. You can set an asset tag
using the Parallels Desktop graphical user interface or the prictl command line utility that comes
with Parallels Desktop.

To set an asset tag using Parallels Desktop GUI:

1 On the Parallels Desktop menu bar, select Actions > Configure to open the virtual machine
configuration dialog.

2 Select Hardware > CPU & Memory.
3 Use the Asset tag field to specify the desired tag.

To set an asset tag using the prictl command line utility, use the following syntax:
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prictl set 1D|name --asset-id tag

where ID | name is the virtual machine ID or name, and tag is the asset tag to set.
To obtain the asset tag in Windows, use the WMIC.exe command:

WMIC SystemEnclosure get SMBIOSAssetTag

For the complete syntax of the WMIC utility please see the Microsoft documentation.
Once set, the asset tag never changes. Even if you perform such virtual machine operations as
cloning, template manipulation, registering, or any other, the asset tag always stays the same. If

you do want to change an existing asset tag for any reason, you can do it manually using of the
methods described above.

Customizing Parallels Desktop Control Center
User Interface

Parallels Desktop Control Center is a part of the Parallels Desktop graphical user interface. It's a
window that lists registered virtual machines that the Mac user can run and use. By default, the
design of this window (graphics, text, etc) is provided by Parallels and looks like the following:

®00 Parallels Desktop Control Center == EEN

Windows 8

(Y | I*

Windows Server 2012 R2

You can customize the design by specifying a URL to your own HTML document that will be
displayed as a banner at the top of the window. The HTML page can contain text, graphics, and
links such as your company logo, a welcome message, a link to a support page, etc. The HTML
document format doesn't have any specific requirements.

The URL must be specified during the preparation stage of the Mass Deployment process (p. 39).
Specifically, you need to specify the URL string and the HTML page size using the following
variables in the mass deployment configuration file (deploy.cfg):

* control center banner url
* control center banner height

* control center banner min width

17
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For the description of how to specify the variables and their values, please see Changing
Deployment Configuration Options (p. 45). The variables are described in the Virtual Machines
section.

The following is an example of Parallels Desktop Control Center displaying a custom banner at the
top.

e00 Parallels Desktop Control Center El=+]

ompany name

Windows 7

O |

Ubuntu Linux

You can download a sample HTML document defining the banner from the following URL:

http://download.parallels.com/desktop/tools/header.zip

Protecting Virtual Machine Configuration

Parallels Desktop Enterprise Edition provides the ability to password-protect the configuration
settings of a virtual machine. When deploying Parallels Desktop, you can set the password in the
source virtual machine before adding it to the deployment package. The deployed virtual machines
will retain the password and the Mac users will not be able to modify the configuration without
providing the correct password.

Using Parallels Desktop Graphical User Interface to Set the Password

The password is set using the Parallels Desktop graphical user interface as follows:

1 In OS X, open Parallels Desktop and select the desired virtual machine.

2 On the Parallels Desktop menu bar, select Actions > Configure to open the virtual machine
configuration dialog.

3 Select Security.
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4 Click the Restrict Editing: Turn On button.

5 Enter the password, then enter it again to verify and click OK.

To change or remove the password:

« To change the password, click Restrict Editing: Change Password, then enter the old and
the new passwords.

- To remove the password, click Restrict Editing: Turn Off, then enter the current password to
remove the configuration lock.

If the password is set and the user tries to view or modify the virtual machine configuration, a dialog
will be displayed asking to provide the password. Without the correct password, the user will be
denied access to the virtual machine configuration dialog.

Using Command Line Tools to Set the Password

In addition to the graphical user interface, you can use the pr1ctl command-line utility to set,
reset, and view the password protection of a virtual machine.

To set the password, type the following command in Terminal:

prlctl set "vm name" --password-to-edit

where vm_name is the virtual machine name in quotes.

You'll be asked to enter a password and then confirm it.

Please enter a new password:
Please confirm password:

To change or remove the password, type the following command:

prlctl set "vm name" --password-to-edit

where vm_name is the virtual machine name in quotes.

You'll be asked to enter the current password.

Please enter current password:

You will then be asked to enter and confirm a new password. To remove the password, leave the
line blank and press Enter twice (when asked to enter and confirm the password).

Please enter a new password:
Please confirm password:

To view the current protection status, type the following command:

prlctl list "vm name" -i

The output will look similar to the following:

Encrypted: no
Edit restricted: yes

19
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Compatibility with Other Parallels Desktop Versions

The configuration protection functionality works only in Parallels Desktop 7 or later. If you set a
password in a virtual machine and then open the virtual machine in an earlier version of Parallels
Desktop, the protection will NOT work (i.e. the user will be able to view and modify the virtual
machine configuration).

You can only set or remove the password in the Enterprise Edition of Parallels Desktop. However, if
the password is set and the virtual machine is opened in the Standard Edition of Parallels Desktop,
the password will continue to work (i.e the virtual machine configuration will remain locked).

Locking Virtual Machine on Suspend

To avoid possible security and privacy issues, a suspended Windows virtual machine can be
completely locked from user interaction and viewing. When this option is enabled and a virtual
machine is suspended, the Windows desktop in the virtual machine window (and in the Parallels
Desktop Control Center) is replaced with a black background and the Windows session is
interrupted. When the virtual machine is resumed, the Windows session is remained locked and the
user will have to enter their user ID and password to unlock it and to see the Windows desktop.

To enable or disable this option:

1 In OS X, open Parallels Desktop and select the desired virtual machine (e.g. the source virtual
machine when preparing it for mass deployment).

2 On the Parallels Desktop menu bar, select Actions > Configure to open the virtual machine
configuration dialog.

Click the Security tab.
Depending on your needs select or clear the On Suspend: [ ] Always lock Windows option.

5 Close the dialog.

Note: The On Suspend: [ ] Always lock Windows option is available only for virtual machine running
Windows with Parallels Tools installed. For all other virtual machines, the option will be hidden.

Encrypted Virtual Machines

A Parallels virtual machine can be encrypted using the Parallels Desktop graphical user interface.
You can also use the prlctl command line utility (included with Parallels Desktop) to perform the
full set of encryption operations on a virtual machine.

The following encryption commmand line options are available:

e Encrypt a virtual machine

20
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prlctl encrypt <ID | NAME>

« Decrypt a virtual machine
prlctl decrypt <ID | NAME>

« Change the encryption password
prlctl change-passwd <ID | NAME>

The <ID | NAME> parameter can be either the virtual machine ID or the virtual machine name.
When encrypting a virtual machine, you'll be asked to enter a password phrase, which will be used
to encrypt the machine. When decrypting a virtual machine, you will be asked to enter the current
password. When changing the password, you'll be asked to enter the old password and then the
new password.

The encryption password will also be required to perform any other command line operation on an
encrypted virtual machine, including starting, stopping, restarting, pausing, suspending, cloning,
deleting a virtual machine, etc. For example, to start an encrypted virtual machine, you'll use the
following command:

$ prlctl start my virtual machine

After executing the command above, you'll be asked to enter the password:

Virtual machine "my virtual machine" is encrypted - password required to continue
operation
Please enter password:

After typing in the correct password, you'll see the following output:

Starting the VM...
The VM has been successfully started.

If you need to execute a command remotely without having to enter the password on every Mac,
you can send the password via standard input (stdin) as shown in the following example:

$ echo mypass | prlctl start my virtual machine

Virtual machine 'my virtual machine' is encrypted - password required to continue
operation

Please enter password:

Starting the VM...

The VM has been successfully started.

If you need to provide two passwords (as with the change-passwd command that changes the
password), you can save the passwords to a text file and then use the following syntax:

$ cat /tmp/pass | prlctl change-passwd my virtual machine

Virtual machine 'my virtual machine' is encrypted - password required to continue
operation

Please enter password:

Please enter new password:

The password has been successfully changed.

The /tmp/pass file in the example above should contain the old password on the first line and the
new password on the second line:

$ cat /tmp/pass
mypass
newpass
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Running Virtual Machines in the Background
(head-less mode)

Parallels Desktop Enterprise Edition allows to run virtual machines as background processes
without the graphical user interface displayed on the Mac desktop. This is sometimes called the
head-less mode. Parallels Desktop is also run as a background process (service) in this mode and
is able to start the virtual machines automatically on Mac startup.

With this functionality you can run multiple virtual machines on a single high-performance Mac
providing virtual machine access to your users. The users can connect to their designated virtual
machines via VNC, RDP, SSH, or other remote tools.

This chapter describes how to set up and run Parallels Desktop and the virtual machines as
background processes.

System Requirements

To run Parallels Desktop as a service, you need:

« Parallels Desktop build 9.0.23350 or later.
« OSX10.7.4 or later.

Configuring Parallels Desktop to Run as a Service

By default, Parallels Desktop is installed as an OS X application with a graphical user interface. To
configure it to run as a service, do the following:
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1

2

3

Open Parallels Desktop and click Parallels Desktop > Preferences in the menu bar. The
preferences window opens.

@00 General

e | B

General | Shortcuts Devices Access Adwenced

Parallels rmernu: IEI Shuw Parallels icon in menu bar
Virtual Machines Folder: | [ ] Parallels =

Virtual Machine Dock Icons: L 0S5 lcon

G

Check for Updates: | Once a week -
Download updates automatically

Creck Now

On Mac Startup: I?I Start Parallels Deskiop as a service

Autornatically starts the Parallels
Desktod service and WMs configured
to start automatically.

On Quit: ™ Disable Resume for Farallels Dasktop

W rtual machnes shut down accord ng
to their startup and shutdown settings.

i ‘P Click the lock to prevent further changes. ()

On the General tab page, select the On Mac Startup: [ ] Start Parallels Desktop as a
service option.

Select the On Quit: [ ] Disable Resume for Parallels Desktop option. When this option is
selected, a virtual machine will be shut down according to its startup and shutdown settings. |
this option is cleared, the virtual machine will be either suspended or stopped regardless of its
startup and shutdown settings or the user input. The rule of thumb is, if you want your virtual
machines to continue running after the Parallels Desktop application is closed, you should
select the Disable Resume for Parallels Desktop option.

To better understand this feature, consider the following scenario:
1. Parallels Desktop is running as a service.

2. The Mac user opens the Parallels Desktop application (the graphical user interface) to
change some setting or to look at the virtual machine window.

f
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3. The user then closes the virtual machine window. Depending on the virtual machine startup
and shutdown settings (see Configuring Virtual Machines to Run in the Background (p.
24)), it will be either kept running in the background, suspended, stopped, or a message will
be displayed to the user asking what to do.

The "Windows 8" virtual machine is running. What
should be done with it?

Choose the action to perform on this virtual machine when the
Parallels Desktop window is closed.

~ Shut Down Cancel | Keep Running |

4. Suppose the message above is displayed and the user clicks Keep Running to keep the
virtual machine running in the background. If the user then closes the Parallels Desktop
application and the Disable Resume for Parallels Desktop option is cleared, the virtual
machine may be suspended or stopped depending on the OS X system preferences
settings. This can happen regardless of the virtual machine startup and shutdown settings
or the user input. The OS X system setting that control this behavior can be found in
System Preferences > General > Closing windows when quitting an application.

|| Close windows when quitting an application

When selected, open documents and windows will not be
restored when you re-open an application

This option is disabled by default in OS X 10.7 and enabled in OS X 10.8. The Disable
Resume for Parallels Desktop option, when selected, overrides this OS X setting for
Parallels Desktop (other OS X applications are not affected). Therefore, if you don't want
your virtual machines to be suspended or stopped, you should either disable the Closing
windows when quitting an application setting in OS X preferences or select the Disable
Resume for Parallels Desktop option in Parallels Desktop preferences.

4 Restart the Parallels Desktop application to start the Parallels Desktop service.

You now need to configure your virtual machines to run in the background. The following section
describes how to do it.

Configuring Virtual Machines to Run in the Background

To configure a virtual machine to run in the background, follow these steps:

1 Open the virtual machine configuration dialog.
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2 Click Options and then select Startup and Shutdown.

e oo Windows 8 - Options
)| . 2 Q
General | Options | Hardware Security Search
Startup and Shutdown
Start Automatically: | When Mac starts -
“¥7 Optimization
{5 sharing Startup delay: |5 sec :
& Applications Startup View: | Same as last time =
L% Coherence On VM Shutdown: | Keep window open =
E. fulisereen On Mac Shutdown: | Suspend =
= Modality
5 d On Window Close: | Keep running in background -
vance
Rellback Moda: | Disable =
Restore Defaults
[ 'P Click the lock to prevent further changes. | 7 )

3 Inthe Start Automatically menu, select When Mac starts. This tells the Parallels Desktop
service to start the virtual machine automatically when OS X starts.

4 In the Startup delay field, set the automatic startup delay, in second. If you have multiple virtual
machines with no autostart delay set, they will start concurrently when you start or restart the
host computer. By using the autostart delay you can reduce the load on the host during
startup. The autostart delay option can also be helpful when one or more virtual machines
depend on a service running in another virtual machine. By setting the autostart delay option for
virtual machines, you can ensure that the virtual machine providing the service is up and
running before the other virtual machines are started. You can also set the startup delay using a
command line interface (see below).

5 Inthe On Mac Shutdown menu, select Suspend. This tells the Parallels Desktop service to
suspend the virtual machine when the Mac is shut down or restarted.

6 Inthe On Windows Close menu, select Keep running in background (or Ask me what to do
if you want a dialog displayed when you close the virtual machine window). This way the virtual
machine will not be accidentally shut down or suspended when you open and close its window
while Parallels Desktop is running as a service.

Set the rest of the options according to your usual preferences.

Close the virtual machine configuration dialog and start the virtual machine.
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You may now close the virtual machine window and the Parallels Desktop application. This will only
close the graphical user interface. The Parallels Desktop service and the virtual machines will
continue to run in the background (provided the virtual machines and Parallels Desktop were
configured correctly as described in this and previous sections of this guide).

Setting Startup Delay Using CLI
To set an automatic startup delay for a virtual machine using a command line interface:
prictl set ID|name --autostart-delay number

where ID|name is the virtual machine ID or name, and number is the startup delay in seconds.

Managing the Parallels Desktop Service

You can manage the Parallels Desktop service using launchctl1, the standard OS X command
line utility that allows to manage daemons, applications, processes, etc. The name of the Parallels
Desktop service is com.parallels.desktop.launchdaemon. See usage examples below.

Examples of using launchctl:

To see if the Parallels Desktop service is running:

$ sudo launchctl list | grep parallels
8421 - com.parallels.desktop.launchdaemon

To stop the Parallels Desktop service:

$ sudo launchctl stop com.parallels.desktop.launchdaemon

To start the service

$ sudo launchctl start com.parallels.desktop.launchdaemon

If Parallels Desktop is running as a service and you want to change the Parallels Desktop or a virtual
machine preferences (or you simply want to see a virtual machine window), you can open the
Parallels Desktop application (the graphical user interface) at any time by double-clicking the
Parallels Desktop icon. While the application is running, you can work with it as usual. When you
are done, you can close the virtual machine window and the Parallels Desktop application. The
Parallels Desktop service will keep running in the background. The virtual machine will keep running
if configured to do so (described in the previous sections of this document).

You can also view and modify Parallels Desktop and virtual machine settings using the standard
Parallels Desktop command line tools. This may be helpful if you can't access the Mac directly (e.g.
it is located in a different building, it doesn't have a monitor and keyboard, etc.). Simply connect to
the Mac using SSH (or some other client) and use the prlsrvctl utility to manage Parallels
Desktop and prlctl utility to manage virtual machines. The documentation for both utilities is
included with Parallels Desktop and is available via command line.
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If Parallels Desktop is running as a service and you want to change it to run as an application, open
the Parallels Desktop application (by double clicking the Parallels Desktop icon) and modify the
Start Parallels Desktop as a service option as described in the previous section. Restart the
Parallels Desktop application for the changes to take effect.

Configuring Expiring Virtual Machine

You can set an expiration date for a virtual machine. This can be a useful option if you are preparing
a virtual machine for a contractor (or a third party user) and want to make sure that it works only for
the duration of the contract.

To set an expiration date for a virtual machine:

In OS X, open Parallels Desktop and select the desired virtual machine.

2 On the Parallels Desktop menu bar, select Actions > Configure to open the virtual machine
configuration dialog.

3 Select the Security tab.

4 An expiration date can only be set on an encrypted virtual machine. If your machine is not yet
encrypted, click Encryption: Turn On, specify an encryption password, and click OK. Make
sure to record the password or you will not be able to start the virtual machine. Wait until the
encryption process finishes.

5 To set an expiration date for the virtual machine, click Expiration Date: Set Date, specify a
password and click OK. Make sure to record the password to be able to change the expiration
settings later. You should keep this password secret to prevent the prospective user of the
virtual machine from changing the expiration date.

6 On the next screen, specify the following options:
« Do not allow this VM start after: specifies the virtual machine expiration date.

« Contact info: specifies the system administrator email, phone number, or other contact
information. This information will be included in the message that will be displayed to the
user when the virtual machine is about to expire. You can include each piece of information
on a separate line.

« Time Server: specifies the time server URL. The virtual machine expiration time will be
checked against this server. The default time server is https://parallels.com.

« Date Check Frequency: specifies how often the date and time should be verified against
the time server. You can specify it in minutes, hours, or days.

» If unable to check date, use VM for: specifies for how long the virtual machine should be
kept working if the time server cannot be reached. For the duration of this period, the virtual
machine will continue to check the date. If it succeeds before this period is over, the counter
is reset and the virtual machine will continue to work normally.

7 Click OK when done entering the expiration info.
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8 To modify the current expiration date or password, click Expiration Date: Change Date or
Expiration Date: Change Password and enter the new values.

Note: When giving the virtual machine to a contractor, make sure to provide them the encryption
password, which is needed to start the virtual machine. Please note that this is NOT the expiration date
password you've set in step 5 above. This is the password you set when you encrypted the virtual
machine.

When the expiration date approaches, the virtual machine user will be notified as follows: a
message will begin to be displayed seven days before the expiration date. The message will be
shown to the user every 24 hours and additionally on every virtual machine startup. Once the date
is reached, the virtual machine will be locked, so the user will not be able to start or resume it
anymore.

Resetting Guest OS User Password

If a virtual machine user forgets the password of their guest OS account (e.g. Windows user
password), it can be reset outside the virtual machine using the command line interface.

To use this functionality the following conditions must be met:

« Parallels Tools must be installed in the guest OS.

« The virtual machine must be running. If it's stopped, start it and wait until you see the guest OS
login prompt.

« Depending on your requirements, the following option can be selected or cleared in the virtual
machine configuration dialog: Security > Require Password to: [ ] Change guest OS
password via CLI. If this option is selected, you will be asked to provide the OS X administrator
password to change the guest OS password from the OS X command line. If the option is
cleared, the administrator password will not be required. By default, the option is cleared.

To reset the password, open Terminal in OS X and enter the following command:

prlctl set vm name --userpasswd username:new password

where:

« vm_name is the virtual machine name. To obtain the list of virtual machines installed on this
Mac, type prlctl list.

¢ username is the guest OS user name.

* new_password is the new password.

Example:

prlctl set My Win8 VM --userpasswd JohnDoe:A12345

If the Require Password to: Change guest OS password via CLI option is selected in the virtual
machine configuration dialog (see above), the command will display the following text and prompt:

Only host administrator can change user password in the guest OS.
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Confirm your administrator credentials.
Username:

Enter the name of the OS X user with administrative privileges and press the Enter key. Type the
user password and press Enter again.

Once the new password is set, you can use it to log in to the guest OS.

Creating Linked Clones

A clone is a copy of an existing virtual machine. The result of a cloning operation is a virtual
machine that is identical to the original virtual machine. A clone has the same configuration as the
original, the same guest OS, and the same installed applications and data. The only exception is
the virtual machine UUID and the MAC address of the network adapter, which are reset
automatically during the cloning operation.

There are two types of cloning operations in Parallels Desktop:

« Full cloning. When you create a full clone, all of the files comprising the virtual machine are
copied, so the new virtual machine is created as completely independent from the original
virtual machine.

« Linked cloning. A linked clone is a virtual machine that shares the read-only areas of the virtual
hard disk with the original virtual machine. When you create a linked clone, the original virtual
hard disk file is not copied. Instead, both the original virtual machine and the clone use the
same hard disk with the shared areas of it marked as read-only. When any of the virtual
machines make any changes to the hard disk data, a new independent storage is created for it
which only that virtual machine can read from and write to. The unaffected areas of the original
virtual hard disk are continued to be shared between the original virtual machine and the clone.
This functionality allows to save a considerable amount of disk space on the Mac hosting the
virtual machines.

Before Your Create a Linked Clone

Before creating a linked clone of an existing virtual machine, make sure that:

« The original virtual machine is stopped.

« The original virtual machine is not encrypted.

Creating a Linked Clone

To create a linked clone of an existing virtual machine:

In Parallels Desktop Control Center, select the virtual machine you want to clone.
2 On the Parallels Desktop menu bar, select File > New Linked Clone.

Select the target folder. By default, Parallels Desktop saves clones in the Documents >
Parallels folder.
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4 Click Save to begin the cloning operation.

Creating a Linked Clone from a Snapshot

In addition to creating a linked clone from the current virtual machine state, you can choose an
existing snapshot of a virtual machine and create a linked clone from it. You don't have to revert the
original virtual machine to the snapshot to create a clone from it.

To create a linked clone from a snapshot:

1 In Parallels Desktop Control Center, select the virtual machine you wish to clone and open its
window.

On the Parallels Desktop menu bar, select Actions > Manage Snapshots.
Select a snapshot from which you wish to create a clone.
Click the New Linked Clone button.

Select the target folder. By default, Parallels Desktop saves clones in the Documents >
Parallels folder.

a b WODN

6 Click Save to begin the cloning operation.

Working with Linked Clones

From the user point of view, a linked clone is just like a regular, completely separate virtual
machine. A user of a linked clone doesn't see what's going on in the original virtual machine and
other linked clones, and vice versa. The virtual hard disk sharing and independent storage
management is done in the background transparently to the virtual machine users.

When you create a linked clone, the virtual hard disk is shared almost completely between the
original and the clone(s). When the users of the linked clones begin to install applications, add data,
or make any other changes inside their virtual machines, a dedicated disk space is allocated to
them where these changes are saved. As a result, the total usage of the host's disk space
increases. Still, a large portion of the system and application data on the original virtual disk
continues to be shared between the original virtual machine and the linked clones, so the overall
host's disk usage remains much lower than if these were independent virtual machines. Provided
that the virtual machine users don't do anything drastic, like installing a different operating system,
the linked clones normally take much less disk space than independent virtual machines.

For the linked clones to work, the following must be observed:

« You must not delete the original virtual machine. If you do, the linked clones will no longer work.

« If you created a linked clone from a virtual machine snapshot, the snapshot and its entire history
in the original virtual machine must not be deleted.

« You should not encrypt the original virtual machine if there are existing linked clones that were
created from it. Doing so will make the linked clones inoperable.
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NetBoot Support for OS X Virtual Machines

NetBoot is a technology from Apple that allows to boot a Mac computer from a network. Parallels
Desktop Enterprise provides NetBoot support for OS X virtual machines. Using this functionality,
you can boot a virtual machine from a network and install (or reinstall) a desired version of OS X on
it.

To NetBoot an OS X virtual machine, the following requirements must be met:

1 A NetBoot server hosting a NetBoot or Netlnstall image must be set up and running on your
network. If you don't know how to do it, read the NetBoot documentation from Apple first.

2 Parallels virtual machines can boot from the default image only, which means that the default
image on the NetBoot server must be the one you want your VMs to boot from.

3 A virtual machine must be of the Mac OS X type. When creating a new virtual machine, select
Mac OS X as the operating system.

4 Unlike physical Macs, a virtual machine will NOT boot from a network if you hold down the N
key. A virtual machine will choose a boot device (hard disk, CD/DVD, network) according to its
boot order list. The following scenarios need to be considered:

« If a virtual machine is blank (OS X is not installed on it yet), it will try to boot from the hard
disk first, then the CD/DVD, and then the network (the default boot order). Since there's no
OS X on either the hard disk or the CD/DVD, the boot from these devices will fail and the VM
will boot from the network (NetBoot).

« [f avirtual machine has a bootable disk but you want it to boot from a network instead,
Network must be specified as the first item in the VM's boot order list. To make this
modification, open the virtual machine configuration dialog, select Hardware > Boot Order,
and then move the Network item to the top of the boot order list.

5 When the virtual machine boots from the network, you can use the standard OS X utilities to
install or reinstall the operating system on it.

Setting Up Local Update Server

With the Enterprise Edition of Parallels Desktop you can set up a local update server on your
network from which Mac users can get Parallels Desktop updates. Updates are released
periodically to improve the performance and reliability of Parallels Desktop. To reduce Internet traffic
when downloading updates, you can set up a local update server, download the available updates
to it, and then set up individual Macs on your network to take the updates from it instead of the
Internet. Read on to learn about setting a local update server.
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Installing Web Server

To set up a Parallels Desktop update server, you'll need a local Web server. Install a Web server on
a computer connected to your network (or use an existing one).

Creating Parallels Update XML File

Create a file named parallels updates.xml on the Web server where it can be accessed via
HTTP. The file is an XML document that should contain specifications for a particular Parallels
Desktop update available on your local updated server.

To create your own document, use the following sample XML document and the XML document
specification that follows it as a reference.

Sample parallels_updates.xml file

<?xml version="1.0" encoding="UTF-8"?>
<ParallelsUpdates schemaVersion="1.0">
<Product>
<ProductName>Parallels Desktop</ProductName>
<UpdateEnabled>1</UpdateEnabled>
<Version>
<Major>8</Major>
<Minor>0</Minor>
<SubMinor>12494</SubMinor>
<SubSubMinor>262214</SubSubMinor>
<StringRepresentation>Sumer</StringRepresentation>
<Update uuid="desktop.8.0.13291.237436.en US.parallels.mac">
<UpdateType>0</UpdateType>
<UpdateName>Build 13291 is available!</UpdateName>
<UpdateDescription>Update description goes here</UpdateDescription>
<FilePath>URL to the update file goes here</FilePath>
<FileSize>219515</FileSize>
<Status>0</Status>
<DateTime>2012-06-17 01:23:00</DateTime>
<Chargeable>0</Chargeable>
<LocaleName>en US</LocaleName>
<DistributorName>parallels</DistributorName>
<0sType>mac</0OsType>
<Ancestry>
<Ancestor>desktop.8.0.12927.482436.en US.parallels.mac</Ancestor>
<Ancestor>desktop.8.0.12473.274921.en US.parallels.mac</Ancestor>
<Ancestor>desktop.8.0.12262.823647.en US.parallels.mac</Ancestor>
</Ancestry>
</Update>
</Version>
</Product>
</ParallelsUpdates>

XML Document Specification

Name Type Description

ParallelsUpdates Root element.
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Product

ProductName
UpdateEnabled

Version

Major

Minor
SubMinor
SubSubMinor

StringRepresentation

Update

UpdateType
UpdateName

UpdateDescription
FilePath

FileSize

Status

DateTime

string

int

int

int

int
string

string
string
int

int

string

Container for Parallels Desktop information.
Use "Parallels Desktop".

Specifies whether the automatic updates are enabled. To
enable updates, specify 1.

Container for Parallels Desktop version information.
Maijor version number.

For Parallels Desktop 7, specify 7.

For Parallels Desktop 8, specify 8.

Minor version number. Specify 0.

Build number. This element may be empty.
Revision number. This element may be empty.
Product codename. This element may be empty.

Container for the information about the Parallels Desktop
update.

Attributes:

uuid — string; a globally unique ID identifying the
product.

The uuid attribute is very important and must contain the
correct information for the update to work. The attribute
value consists of the following parameters (substrings)
separated by periods (see the provided XML example):

desktop — specify "desktop".
major — major version number (8).
minor — minor version number (0).
build — build number.

revision — revision number.
locale — locale ("en_US", "de_DE", etc).
vendor — vendor ("parallels").
platform — platform ("mac").
Update type. Specify 0.

The name for the update, user-defined.
The update description.

A URL to the update file on your local update server. The
actual update files can be obtained from Parallels.

The update file size, in megabytes.
Specify 0.

Date and time when the updated was published. Use the
following format:

yyyy-mm-dd hh:mm:ss
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Chargeable int Specify 0.

LocaleName string | Locale name ("en_US", "it_IT", etc).
DistributorName The update distributor name. Specify "parallels”.
OsType Operating system type. Specify "mac".

Container for the list of updates that directly preceded this

Ancestry update
An individual Parallels Desktop update information.

This element may appear more than once in the same
document, one for each update.

The value is combined using the following parameters
(substrings) separated by periods (see the provided XML
example):

desktop — specify "desktop".

Ancestor sting major — Parallels Desktop major version number.
minor — MINOr version number.
build — build number.
revision — revision number.
locale — locale ("en_US", "ru_RU", etc.)
vendor — vendor ("parallels").

platform -— platform ("mac").

Configuring Individual Macs

The next step involves configuring individual Macs to take their updates from the local update
server. This can be done automatically during the mass deployment of Parallels Desktop by
modifying the appropriate deployment configuration option. Please see the Changing Deployment
Configuration Options section (p. 45) for the complete info (see the description of the Software
Updates section of the configuration file).

If you have an existing Parallels Desktop installation that was not configured for automatic updates
during deployment, then read on to learn how to do it manually.

Note: The information provided here applies only to Parallels Desktop installations that were not
configured for automatic updates during the mass deployment process.

To configure the Parallels Desktop automatic updates, you need to modify the Parallels Desktop
property list file on a Mac as follows:

1 Findthe com.parallels.Parallels Desktop.plist file located in the
Library/Preferences sub-folder in the user's home folder. This is the Parallels Desktop
property list file that contains the user-specific information.

34



Parallels Desktop Enterprise Edition Features

2 Open the file using the Property List Editor application (included with OS X).

3 Set the update policy by modifying the Application
Preferences.VolumeLicenseUpdatePolicy property. If the property doesn't exist, add
it to the file specifying its data type as String. Set the property value using one of the following
options (see also the Notes subsection below):

« "Parallels" — when this value is set, the updates will be downloaded from the Parallels
update server via the Internet. The value is case-sensitive.

« Complete URL of the parallels updates.xml file residing on your local update server.
For example, "http://10.0.0.1/pdfm/v8/en_us/parallels/parallels_updates.xml". When the
URL is specified, the updates will be obtained from the local update server.

¢ "None" — automatic updates are disabled. The value is case-sensitive.

4 Specify how often Parallels Desktop should check for updates. This is done by modifying the
Application Preferences.Check for updates property. If the property doesn't exist,
add it to the file specifying its data type as Number. Specify the property value using one of the
following options:

« 0-— Never.

« 1 — Once a day.

+ 2 — Once a week.
+ 3 — Once a month.

5 Set the automatic download option. Find the Application preferences.Download
updates automatically property. If it doesn't exist, add it to the file specifying its data
type as Boolean. Set the property value using one of the following options:

- true — Download updates automatically. Specify this value when using a local update
server.

« false — Notify the user about the updates but don't download them automatically. This
option is useful only when updates are downloaded from the Parallels update server and the
user has full control over the update functionality.

6 Save the file and close the Property List Editor application.
Note: If Parallels Desktop is running while you are modifying the p1ist file, it will have to be restarted for
the changes to take effect.

Notes

On initial Parallels Desktop activation using an Enterprise Edition key, the Parallels Desktop update
properties will be absent from the com.parallels.Parallels Desktop.plist file. In such a
case, a Mac user will be able to configure Parallels Desktop automatic updates using the Parallels
Desktop graphical user interface.
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When the update-related properties are added to the com.parallels.Parallels
Desktop.plist file, the automatic updates will be performed according to the specified values.
In addition, the value of the Application Preferences.VolumelLicenseUpdatePolicy
property will affect the Parallels Desktop update-related elements in the Parallels Desktop graphical
user interface as follows:

- If the property contains a URL of the local update server or "None", the Parallels Desktop
update-related controls will be disabled (grayed out) in the Parallels Desktop graphical user
interface. The displayed settings will have no effect on how the Parallels Desktop updates are
carried out. Therefore, the user will not be able to configure automatic updates or check for
updates manually.

« If the property doesn't exist, has no value, or contains "Parallels" as a value, the Parallels
Desktop update controls will be enabled in the user interface giving the user the ability to
configure automatic updates and check for updates manually.

Note: The Application Preferences.VolumeLicenseUpdatePolicy property value has no
effect when Parallels Desktop is activated using the Parallels Desktop Standard Edition license key.

Customizing Request Support Option

The Parallels Desktop graphical user interface has a menu option named Help > Request
Support. By default, this option opens a screen with the Parallels technical support information.
With the Enterprise Edition of Parallels Desktop you can customize the action performed by this
menu option.

The following choices are available:

« The menu option can display the following default text message: "Please contact your system
administrator for assistance." The message cannot be modified.

« The menu option can open a custom URL, such as a corporate Help Desk or a wiki page. The
system administrator can specify a custom URL (read below).

The customization can be done during mass deployment of Parallels Desktop by modifying the
appropriate deployment configuration parameter. Please see the Changing Deployment
Configuration Options section (p. 45) for the complete info (see the description of the Help and
Support section of the configuration file).

You can also make these changes manually on an individual Mac as follows:

Log in to the Mac.

2 Inthe Finder, navigate to the /Users/<User Name>/Library/Preferences directory
and locate the com.parallels.Parallels Desktop.plist file.

3 Open the file using the Property List Editor application, which is included with OS X.
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4 Find the SsupportRequestUrl property in the file. If the property doesn't exist, add it to the
file specifying its data type as String.

5 To specify the action that should be performed by the Help > Request Support menu, set the
value of the SupportRequestUrl property:

« To display the default text message, clear the property value.

« To open a URL, specify the full URL to the desired Web page or a resource.

Note: The SupportRequestUrl property value has no effect when Parallels Desktop is activated using
the Parallels Desktop Standard Edition license key.

Participating in Customer Experience Program

The Parallels Customer Experience Program is a feedback solution that allows Parallels Desktop to
automatically collect usage statistics and system information that will help Parallels to develop new
features and updates for future releases. When you install Parallels Desktop on a Mac computer, it
is automatically set up to participate in the Customer Experience Program. If you want to turn the
participation off, you can use the prlsrvctl command line utility and execute the following
command on every Mac after installing Parallels Desktop:

prlsrvctl set —--cep off

To turn the participation in the Customer Experience Program back on, execute the following
command:

prlsrvctl set --cep on

The same actions can also be done through the Parallels graphical user interface by clicking
Parallels Desktop > Preferences > Advanced and then selecting (or un-selecting) the Feedback
option.

If you are using the Parallels mass deployment package to deploy Parallels Desktop, you can set
this option in the deployment configuration file (p. 45). When that's done, Parallels Desktop will be
installed on a Mac with this option already set as desired.

Parallels Desktop License Renewal

A Parallels Desktop Enterprise Edition license is renewed automatically via the Internet. When
Parallels Desktop is running on a Mac, it sends a license renewal request to the Parallels Key
Administrator server at random intervals. Once a license update is available, it is automatically
downloaded and installed.

Parallels Desktop uses port 443 (the standard SSL port) to communicate with the Parallels Key

Administrator server from which it obtains license updates. If you are not using the most recent
version of Parallels Desktop, please read the Note section below for additional information.

37



Parallels Desktop Enterprise Edition Features

Note

Port 443 is used for license renewal by Parallels Desktop 8 build 8.0.18345.820589 and newer.
Older versions of Parallels Desktop use a non-standard port 5224.

For more information about the Parallels Desktop Enterprise Edition licensing, please contact your
Parallels sales representative
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CHAPTER 4

Mass Deployment of Parallels Desktop and
Virtual Machines

This chapter describes mass deployment of Parallels Desktop Enterprise Edition. It provides step-
by-step instructions on how to prepare the deployment package and how to deploy it using the
available deployment tools.

In This Chapter
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Prerequisites

To mass deploy Parallels Desktop Enterprise Edition you'll need:

A Mac computer on which you'll prepare the Parallels Desktop deployment package. The Mac
must have Parallels Desktop installed in order create and configure virtual machines to be
deployed together with Parallels Desktop itself.

A Windows or a Mac computer from which you'll be performing the deployment. If you are
using Parallels Mac Management for SCCM, you'll be deploying Parallels Desktop from a
Windows computer running the Configuration Manager console. If you are using Apple Remote
Desktop, you'll be deploying Parallels Desktop from a Mac running the Apple Remote Desktop
Admin. For other remote deployment tools, see their respective system requirements.

The Parallels Desktop for Mac installation image file (the file with the ".dmg" extension). This is
the same image file that you use to install Parallels Desktop on a single Mac.

A Parallels Desktop for Mac Enterprise Edition license key provided to you by your Parallels
sales representative.

The Parallels Desktop Autodeploy.pkg file contained in the same .zip file that
contains this documentation. The file is an OS X installation package that contains the
framework for deploying Parallels Desktop. If for any reason you cannot find it, you can
download the .zip file containing it from the following location:

http://download.parallels.com/desktop/tools/pd-autodeploy.zip
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Note: If you've deployed Parallels Desktop in the past and have a prepared deployment package from
that time, don't use it because it may not be compatible with your build of Parallels Desktop. Always
download the latest version of the Parallels Desktop Autodeploy.pkg from the Parallels
website using the link above.

Download or copy the deployment package file to the Mac computer where you'll be preparing
it for the deployment of Parallels Desktop and virtual machines.

For the list of hardware and operating system requirements for running Parallels Desktop, please
refer to Parallels Desktop User's Guide.

Supported Deployment Tools

Parallels Desktop Enterprise Edition can be deployed to Macs using one of the available Mac
package deployment tools. The available options are described below.

Parallels Mac Management for Microsoft SCCM 2012

Parallels Mac Management for Microsoft System Center Configuration Manager (SCCM) is an
optimal solution that offers comprehensive management of Mac devices throughout the company.
One of the features of Parallels Mac Management is the ability to deploy Parallels Desktop on
managed Mac computers.

The complete instructions on how to use Parallels Mac Management to deploy Parallels Desktop
are provided later in this guide.

Other Mac Management Tools

If you don't use Parallels Mac Management for Microsoft SCCM to manage your Macs, you can
use one of the following tools to deploy Parallels Desktop:

« Apple Remote Desktop (ARD)
«  JAMF Casper Suite
« |BM Endpoint Manager

The complete instructions on how to use Apple Remote Desktop are provided later in this guide.
For the instructions on how to use other tools, please see their respective documentation.
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Preparing Parallels Desktop Deployment Package

Before the Parallels Desktop deployment package can be deployed on target Macs, the Parallels
Desktop installation image must be added to it and the Parallels Desktop license key must be
specified. When deploying virtual machines, the virtual machine files must also be included in the
package. The deployment configuration options can then be customized according to your
requirements.

The following sections describe how to add the necessary files and how to make the desired
modifications to the Parallels Desktop deployment package.

Adding Parallels Desktop Installation Image

To deliver the Parallels Desktop installation image to target Macs, you need to include it in the
deployment package.

To add the image file to the package:

1 On a Mac computer to which you've downloaded the Parallels Desktop
Autodeploy.pkg file, right-click the file and then click Show Package Contents.

2 Expandthe Parallels folder to see its contents. The folder should contain the deploy.cfg
file. This is the deployment configuration file, which you will modify later.

8ne & Parallels Desktop Autodeploy.pkg

PEFSEE R ERIERY Q _
| |
| Name a| Kind |
» [ Contents Folder
¥ [ Parallels Folder

B deploy.cfg TextEdit Document
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3 Copy the Parallels Desktop installation image file to the Parallels folder. Your package
contents should now look like this:

e ne w Parallels Desktop Autodeploy.pkg
() (B ) (%) (8] (=] @
S : . : |
| Mame 4 Kind _
» [ Contents Folder
¥ [ Parallels Folder

7 deploy.cfg TextEdit Document

2| ParallelsDesktop-9.0.23032.914872 .dmg Disk Image

Adding Virtual Machines

To add a virtual machine to the deployment package, simply copy its file to the Parallels folder
(the same folder in the package that contains the deploy.cfg file and the Parallels Desktop
installation image). You can include more than one virtual machine. Once the virtual machine is
added, your package contents should look similar to the following:

e 0o 4 Parallels Desktop Actodep oy.pky
EIDIE - S IEEE e
‘MName a| Kind
» [ Conterts Folder
¥ [ Parallels Folder
- deploy.cfg TextEdit Document
2| ParallelsDesktop-9.0.23032.914872 .dmg Disk Image
B Windows &.pvm Parallels virtual machire

42



Mass Deployment of Parallels Desktop and Virtual Machines

Before copying a virtual machine to the deployment package, you should configure it according to
your needs. Read the following subsections for the information about the modifications that you
can make to the virtual machine configuration prior to deploying it.

Installing Parallels Tools

Parallels Tools is a collection of utilities and drivers that vastly improve the virtual machine
performance and enable some features that are not available otherwise. Parallels Tools are included
with every copy of Parallels Desktop and are highly recommended to be installed in every virtual
machine right after an operating system is installed in it. Your source virtual machine should have
Parallels Tools installed.

Generating Windows SID and Computer Name

When you deploy a virtual machine that runs Windows as a guest operating system, the deployed
copies of Windows will have the same Windows Security ID (SID) and computer name as the
source. You can set up Windows in the source virtual machine in such a way that the SID and
computer name will be reset in each deployed copy of Windows on its initial startup.

Using Sysprep to Reset SID and Computer Name

Microsoft System Preparation (Sysprep) is a Microsoft tool that can be used to prepare Windows to
be deployed on other computers. If your virtual machine is running Windows 8, Windows 8.1,
Windows Server 2012, or Windows Server 2012 R2, use the Sysprep.exe command-line utility.

To reset the security ID (SID), include the /generalize option as shown in the following example:
Sysprep /generalize

To change the computer name, use the /oobe option that enables the user to customize their
Windows operating system, including naming the computer:

Sysprep /generalize /shutdown /oobe

For the complete description of the command-line version of Sysprep, please refer to Microsoft
documentation.

If your virtual machine is running another version of Windows, download the latest version of
Sysprep for that version from the Microsoft website and use it according to Microsoft instructions.

Other Configuration Options

When preparing a source virtual machine for mass deployment, you may change any of its
configuration settings according to your needs. The following list describes a few common options:

« Shared Folders and Profiles. Parallels Desktop offers great flexibility in bridging the
capabilities of OS X and your guest operating system by configuring shared folders and profiles.
Think over which files and folders you wish to share between the two operating systems and
set up them in advance.
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« Configuring USB Settings. Hardware devices that connect through USB ports including
printers and removable drives can only be used by one operating system at a time. By default,
Parallels Desktop will ask the user which OS to connect the device to when a new device is
detected. This default can be changed by making all USB devices connect only to OS X or to
the guest operating system.

- Installing Applications. You can install all the necessary applications in the virtual machine
before deploying it.

» Parallels Desktop Enterprise Edition Options. Parallels Desktop Enterprise Edition provides
additional configuration options. With the Enterprise Edition you can:

» Password-protect the virtual machine configuration.

« Set up a local update server and specify the Parallels Desktop automatic update options.
» Customize the "Request Support" option.

» Configure participation in the Customer Experience program.

For the information on how to configure these options, see Changing Deployment
Configuration Options (p. 45) and Parallels Desktop Enterprise Edition Features (p. 16).

For the complete information about Parallels virtual machine configuration, please refer to the
Parallels Desktop User's Guide.

Supplying Parallels Desktop License Key

Parallels Desktop Enterprise Edition license key is required to activate Parallels Desktop on target
Macs. The key must be embedded in the deployment package.

To embed the license key in the deployment package:
1 Right-click the Parallels Desktop Autodeploy.pkg file and then click Show Package
Contents.

2 Expandthe Parallels folder to see its contents. The deploy. cfg file contained in the
folder is a deployment configuration file. One of the parameters is used to specify the Parallels
Desktop license key.

Open the deploy.cfg file in a text editor.

Find the L.icense section in the file and enter your Parallels Desktop Enterprise Edition license
key as a value of the 1icense key variable. The license must be supplied in the following
format: " XXX -XXXXHX - XXX -XXXXXK-XXXXXX" (including the quotes and dashes).

5 Savethe deploy.cfgfile.

To learn about other configuration parameters in the deploy. cfqg file, please read the
Changing Deployment Configuration Options section (p. 45).

Note: Parallels Desktop activation requires Internet access. The Parallels Desktop activation routine uses
port 443 to communicate with Parallels licensing server. Please make sure that the Macs on which you
plan to deploy Parallels Desktop can communicate through this port.

44



Mass Deployment of Parallels Desktop and Virtual Machines

Changing Deployment Configuration Options

The deployment package contains a special script, which is automatically executed on a target
Mac after the package is transferred and the Parallels Desktop software is installed on it. The script
performs the necessary actions on the Mac to finalize the deployment. The script reads the
configuration parameter values from the deploy. cfg file contained in the Parallels folder of the
Parallels Desktop Autodeploy.pkg file. You can modify the configuration parameters as
needed.

The following tables describe the configuration parameters in the deploy. cfg file. You can open
the file for editing in a text editor.

License

The License section is used to specify a Parallels Desktop Enterprise Edition license key:

Variable Description

Specifies the Parallels Desktop license key. See Supplying

1i k
tcense_key Parallels Desktop License Key (p. 44) for more info.

Virtual Machines

The Virtual Machines section allows to modify the virtual machine deployment options:

Variable Description
Specifies the registration mode for the deployed virtual machines.
Possible values:

"Private" — The virtual machines will be registered for the
active user only. The virtual machines will be placed into the

, /Users/<user>/Documents/Parallels folder.
vm_register mode

"Shared" — The virtual machines will be registered for all users
of a Mac. The virtual machines will be placed into the
/Users/Shared/Parallels folder.

The default destination folder for virtual machines can be modified
using the vm_destination folder variable (see below).

Specifies whether the virtual machine SMBOIS ID (hardware ID)
will be regenerated. Each Parallels virtual machine is assigned a
universally unique SMBIOS ID when it is created. When you
deploy a virtual machine to many Macs, each resulting copy of
the machine will have the same SMBIOS ID. This is the default
vm_reset hwid behavior and should not be normally changed. If your enterprise
management system relies on unique SMBOIS IDs, you can
change the value of the vm_reset hwid variable as follows:

"no" — Keep the original SMBIOS ID.

"yes" — Regenerate the ID.

45



Mass Deployment of Parallels Desktop and Virtual Machines

vm _deploy mode

vmm_destination folder

46

Specifies whether the virtual machines will be copied or moved
from the deployment package to their target folders on a Mac.

Possible values:

"Copy" — Copy the virtual machine from the package to the
destination folder.

"Move" — Move the virtual machine from the package to the
destination folder.

Before a virtual machine can be registered in Parallels Desktop, it
needs to be copied (or moved) from the deployment package to

a folder on the Mac. You can specify whether to use a Copy or a
Move operation.

Copying is slower but must be used if the deployment package is
read-only or is placed on a network share. The virtual machine file
will not be removed from the package after it's been copied to a
Mac.

Moving is fast and can be used when the deployment package is
copied directly to a Mac. If the virtual machine destination folder
and the deployment package are placed on the same mount
point, the move operation completes almost instantly. The virtual
machine is removed from the package as a result. Note that
moving will be as slow as copying if the virtual machine
destination folder and the deployment package are placed on
different mount points.

Allows to change the default destination folder for virtual
machines. The default folder is determined by the value of the
vm_register mode variable (see above). The
vm_destination folder variable allows to change the
default folder while keeping the selected virtual machine
registration mode.
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This variable takes a name of a virtual machine file and allows you
to change the destination location and/or name of the target
virtual machine.

The virtual machines contained in the Parallels folder of the
deployment package will be copied to a default location on a
Mac, which is determined by the vm_register mode
variable (or the vimn_destination folder variable ifis
present). If you have more than one virtual machine in this folder,
you can specify a different destination location and/or name for a
specific virtual machine if needed.

To specify a different location, you need to define a variable/value

<VM file name> pair as shown in the examples below. The variable name should

- - be the same as the virtual machine file name (including the ".pvm"

extension). The variable value should contain an absolute path
where you want the virtual machine to be copied on a Mac. You
can specify a different destination location, a different virtual
machine name, or both. Note that only the specified virtual
machine will be copied to the specified location. All other virtual
machines will be copied to the default location.

Examples:
"Shared VM.pvm"="/Users/Shared/Shared VM.pvm"

"Private VM.pvm"="~/Documents/Parallels/Private
VM. pvm"

The following three variables belong to the same sub-section which allows to customize the Parallels Desktop
Control Center by displaying a custom HTML banner at the top of its window. For additional information, see
Customizing Parallels Desktop Control Center (p. 17).

The URL of a custom HTML page to be displayed as a banner in

the Parallels Desktop Control Center window.
control center banner url

To disable the banner, comment out the variable or specify an
empty string as a value.

The banner height, in pixels. The recommended value is 350.

control center_banner_height To use the current value (if you are updating Parallels Desktop on

a Mac), comment out the variable.

The banner minimum width, in pixels. When resizing the Control
Center window, its minimum width will be limited accordingly. The

control center banner min widt récommended value is 350

h To use the current value (if you are updating Parallels Desktop on

a Mac), comment out the variable. To disable the minimum width
limitation, comment out the variable or specify O (zero) as a value.

Launch Options
The Launch Options section allows to configure Parallels Desktop to start as a service on host

startup:

Variable Description

Specifies whether Parallels Desktop should run as an application

start pd as service )
- - - Or as a service.
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The value of "yes" specifies that Parallels Desktop will run as a
service. The service will start automatically on host startup and
will stop on host shutdown. The service can be managed by
launchctl (the standard OS X command line utility that allows to
manage daemons, applications, processes, etc.).

The value of "no" specifies that Parallels Desktop will run as an
OS X application. The user will have to start and exit Parallels
Desktop manually.

Depending on whether Parallels Desktop is already installed on a
target Mac or not, the following will happen:

- If Parallels Desktop is already installed on a Mac as a service
and the value of "no" is specified, the new installation will set up
Parallels Desktop to run as an application.

- If this option is commented out and Parallels Desktop is already
installed on a Mac, no changes will be made to the way Parallels
Desktop runs.

- If this option is commented out and Parallels Desktop is not
installed on a Mac, it will run as an application.

Software Updates

The Software Updates section allows to configure the Parallels Desktop automatic updates:

Variable Description

Specifies where the updates will be downloaded from.
Possible values:

"Parallels" — Download the updates from the Parallels
website over the Internet.

updates_url "None" — Turn off automatic updates.

<URL> — Download the updates from a local update server. The
variable should contain a complete URL (in quotes) of the
parallels updates.zxml file on your local Web server. For
more information, please see Setting Up Local Update Server
(p. 31).

Specifies how often Parallels Desktop should check for updates.
Possible values:

"0" — never
updates auto check
"1" — once a day

"2" — once a week
"3m — once a month
Specifies the automatic update download options:

"on" — Download the updates automatically. This value should

updates auto download be specified when using a local update server.

"of£" — Notify the user about the updates but don't download
them automatically. This option is useful only when updates are
downloaded from the Parallels website and the user has fulll
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control over the update functionality.

Help and Support

The Help and Support section allows to configure the "Request Support" option in the Parallels
Desktop graphical user interface.

Variable Description

Specifies a URL of a page that will be displayed when user
selects the Help > Request Support menu option in the Parallels
Desktop graphical user interface. To display the default message,
specify an empty string (this is the default behavior). To display
your own Web page (help desk, wiki, etc.), specify its URL. See
also Customizing Request Support Option (p. 36).

support url

Specifies a URL that will be included in error message dialogs
related to licensing operations. The URL should point to a web
page or a resource that the user can visit to get help with the
problem.

. . The error message appears when there's a problem with
lic_admin url activating, renewing, or deactivating a Parallels Desktop license. If
you specify a URL using this variable, it will be included in the
message dialog in the form "For details click <URL>". If you don't
specify a URL (comment out the variable or specify an empty
string), the default "Contact your system administrator" message
will be displayed.

Problem Reporting

The Problem Reporting section allows to specify whether Parallels Desktop problem reports
should contain screenshots of the OS X and the virtual machine desktops. You may wish not to
include the screenshots in the problem reports for security reasons.
Variable Description

Possible values:

"yes" — Include screenshots of the OS X and the virtual

report allow screenshots . i
P - - machine desktops in Parallels Desktop problem reports.

"no" — Do not include the screenshots.

Customer Experience

The Customer Experience section allows to specify whether the participation in the Parallels
Customer Experience Program is turned on or off. The Parallels Customer Experience Program is a
feedback solution that allows Parallels Desktop to automatically collect usage statistics and system
information that will help Parallels to develop new features and updates for future releases.

Variable Description
Possible values:

cep participation
"of £" — participation in the program is turned off.
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"on" — participation in the program is turned on.

See also Participating in Customer Experience Program (p.
37).

Deploying Parallels Desktop and Virtual Machines
on Macs

Once the deployment package contains all the necessary files and is configured as desired, you
can deploy it to Macs using one of the available remote Mac management tools. This section
provides instructions on how to deploy Parallels Desktop using the following tools:

« Parallels Mac Management for Microsoft SCCM 2012 (p. 50)
«  Apple Remote Desktop (p. 52)

Note: If you are looking for the information on how to use NetBoot to deploy an OS X image with
Parallels Desktop pre-installed, please read the Deploying OS X Image Using NetBoot section (p. 56).

Deploying with Parallels Mac Management for SCCM 2012

Parallels Mac Management for Microsoft SCCM 2012 provides facilities to deploy Parallels Desktop
on Mac computers from the Configuration Manager console. The deployment is done through the
SCCM Software Distribution feature. To use this functionality, you need Microsoft System Center
Configuration Manager 2012 fully deployed and operational and the Parallels Mac Management
software installed and running. For the complete information about Parallels Mac Management for
SCCM, please read the administrator's guide that came with it.

The basic steps involved in deploying Parallels Desktop are:

1 Prepare the Parallels Desktop deployment package. We've described this step earlier in this
guide.

2 Create a software distribution package using the Configuration Manager console.
3 Send the package to a distribution point.
4 Deploy the package.

The following describes steps 2-4 in detail.

Creating a Software Distribution Package

The Parallels Desktop deployment package is distributed to Macs using the standard Configuration
Manager functionality:
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In the Configuration Manager console, navigate to Administration / Overview / Application
Management / Packages.

On the toolbar, click Create Package.

Use the Create Package and Program Wizard to create a software distribution package and
a program.

On the Package page, specify the package name, description, and other information. Select
the This package contains source files option and then click the Browse button. Browse for
and select the Parallels Desktop Autodeploy.pkg folder. When done, click Next.

On the Program Type page, select the Standard program item and click Next.

On the Standard Program page, specify the information about the program. Type the following
in the Command line field:

chmod 700 "Parallels Desktop
Autodeploy.pkg/Contents/Resources/postflight" && installer -pkg
"Parallels Desktop Autodeploy.pkg" -target /

When done specifying the program information, click Next.
Click Next on the Requirements page.

Review the summary and click Next to create the package.

Sending the Package to a Distribution Point

To send a copy of the package to a distribution point, right-click the package of interest and click
Distribute Content in the pop-up menu. Use the Distribute Content Wizard to specify a
distribution point to which you want to send the package.

Please make sure that the distribution point is properly configured. For more information, see the
Parallels Mac Management Administrator's Guide.

Deploying Parallels Desktop

To deploy Parallels Desktop:

1

In the Configuration Manager console, right-click the package and then click Deploy in the
pop-up menu. The Deploy Software Wizard opens.

On the General page, click the Browse button next to the Collection field and select the
collection containing your Macs (e.g. All Mac OS X Systems). Click OK and then click Next.

On the Content page, verify the distribution point info and click Next.
Click Next on the Deployment Settings page.

On the Scheduling page, specify the schedule for this deployment. Click New to specify the
assignment schedule. When done, click Next.

Use the default values on the rest of the wizard pages and complete the wizard.
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The package will be advertised to Macs in the specified collection and will be distributed to them
according to the specified schedule.

Deploying with Apple Remote Desktop

To use Apple Remote Desktop, you need Apple Remote Desktop Admin, which should run on your
administrator Mac, and Apple Remote Desktop client, which should run on client Macs.

Apple Remote Desktop Admin doesn't come standard with OS X. You will have to obtain the
software from Apple and install it on a Mac from which you are deploying Parallels Desktop. Apple
Remote Desktop client is installed during the standard OS X installation.

Note: Before continuing, please verify that the versions of Apple Remote Desktop Admin and each
instance of Apple Remote Desktop client match. If they don't, update the necessary software.

Configuring Remote Management Services on Target Macs

For a remote management tool (ARD in our case) to be able to distribute the software, the Remote
Management Services have to be configured in OS X on each individual Mac. In order to do so, you
need to log in to each Mac and perform the following steps:

In OS X, open System Preferences.

Click Sharing.

In the Service list, select Remote Management.
Click Options.

Select the following options: Observe, Control, Open and quit applications, Change
settings, Delete and replace items, Copy items (see the picture below).

a A ON =

All local users can access this computer to:
@] Observe
IET Control
|_| Show when being observed
|| Generate reports
™ Open and quit applications
4 Change settings
@IDeIete and replace items
|| Start text chat or send messages

| Restart and shut down

™ Copy items

| cancel | [ OK |

Click OK.

Close System Preferences.
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Deploying the Package

To deploy the package to Macs:

1 On the administrator Mac, open the Finder and click Applications > Remote Desktop to
display the main window of Apple Remote Desktop.

Note: If you have set up a Task Server, you can deploy the package from that server.

2 Click All Computers in the left section of the ARD main window. The Mac computers
connected to your network are displayed in the right pane of the window.

eNe Remote Desktop
G N Y e . o Q
Observe Control Curtain Copy Install UNIX Reports Spotlight

|1 Al Computers Name & Current Status IP Address Current Application

IE| scanner
> & Task Server
¥ i) Active Tasks
¥ [7 History

2 Mac-000066 Available 10.30.17.229

€ 5]

+ - Il 4= 1computer 1 selected

3 Select the desired destination Macs and click Install in the ARD toolbar (or select Manage >
Install Packages menu). The Install Packages window opens.

53



Mass Deployment of Parallels Desktop and Virtual Machines

4 Addthe parallels Desktop Autodeploy.pkg file to the Packages list either by
dragging it there with the mouse or by locating the package using the '+' button

XaXe Untitled |

o Install Packages Template: | Mone

Packages

« Parallels Desktop Autodeploy

+ Drag packages into the list or click “+" to locate them.

After installation: (%) Don't restart
() Artempt restart, allow users to save documents
O Force an immediate restart
Run this task from: ) This application
() The Task Server on this computer
If a problem occurs: [ Stop the copy on all targets

Security: [ Encrypt network data

Network usage: [ Limit to kilobytes per second
Name & Status
Mac- 000066 Available
1 computer
Cetadila p
[ Schedule... ) [ Save ) ( Install )

A

5 Click Install to distribute the deployment package to selected Macs. The installation progress is
displayed in the main window. The result of the package distribution to each individual Mac is
displayed in the Status column.

When the package is distributed to a Mac, it runs on it and installs Parallels Desktop and the virtual
machine(s). It then activates Parallels Desktop using the supplied license key.

Using Apple Remote Desktop Templates

Apple Remote Desktop allows to save package installation settings as templates. This feature may
be useful if you need to deploy Parallels Desktop more than once using different settings. For
example, you may have a virtual machine specifically configured for your developers and another
one configured for your graphics designers or quality assurance engineers. Instead of modifying the
deployment package every time you need to deploy Parallels Desktop to a specific group of Mac
users, you can create separate packages and save them as templates.

To create an ARD template:
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On the administrator Mac, open Apple Remote Desktop.
Click All Computers in the left pane of the ARD main window.

Select the computers where the deployment package is to be installed and click Install in the
ARD toolbar.

4 |n the Install Packages window, add the desired Parallels Desktop deployment package either
by dragging it to the top area of the displayed window or locating it by using the '+' button.

5 Save current installation setup as a template by selecting Save as Template from the
Template pop-up menu located in the upper right-hand corner of the Install Packages
window.
®00 untitled i

‘we Install Packages Templalj ¥ MNone

o

Save as Template...
|Packages Edit Templates List...

** Parallels Desktop Autodeplo

| + | - | Drag packages into the list or click “+" to locate them.

After installation: ) Don't restart
() Attempt restart, allow users to save documents
CJ Force an immediate restart
Run this task from: (® This application
(7) The Task Server on this computer
If a problem occurs: [ Stop the copy on all targets

Security: [] Encrypt network data

Metwork usage: [ Limit to kilobytes per second
-
|Status
E vimacmini Available
1 computer
Schedule. .. ( Save ) E Install )

&
6 In the displayed window, specify the name that you would like to use for the template and click
OK.

The next time when you are ready to deploy Parallels Desktop to a specific group of Mac users,
simply select the desired template from the same Template pop-up menu in the Install Packages
window and then click Install.
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Deploying OS X Image Using NetBoot

If you are using NetBoot to deploy an OS X image with Parallels Desktop Enterprise Edition pre-
installed, some additional steps need to be taken to properly activate a copy of Parallels Desktop
on individual Macs.

The following describes the process of installing Parallels Desktop in OS X and creating an image
from it suitable for NetBoot deployment:

Install OS X on a Mac.
Install Parallels Desktop Enterprise Edition.
Make sure your Mac can connect to the Internet.

Activate Parallels Desktop using your Enterprise Edition license key.

a A ON =

Tune Parallels Desktop settings and install and configure virtual machines according to your
needs.

6 In OS X, open Terminal and deactivate the Parallels Desktop license by typing the following
command:

prlsrvctl deactivate-license
On successful license deactivation, you should see the following output:
The License has been successfully deactivated

7 Quit Parallels Desktop.

In Terminal, type the following command to prepare Parallels Desktop to activate a license in
deferred mode:

prlsrvctl install-license —--key <key> --deferred

where <key> is the Parallels Desktop Enterprise Edition license key.

On success, you should see the following output:

The License has been successfully prepared for deferred activation.

This means that the next time Parallels Desktop starts, it will try to activate the license
automatically. The Internet connection is required for activation. If a Mac can't connect to the
Internet, the Parallels Desktop license activation will be postponed until the Internet connection
is available.

9 You can now create an OS X image from this system and deploy it to other Macs in your
enterprise using NetBoot.
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CHAPTER 5

Parallels Desktop Command Line Interface

Parallels Desktop Enterprise Edition comes with two command-line utilities: prlsrvetl and
prlctl.

prisrvctl

The prlsrvctl utility is used to administer Parallels Desktop. The tasks that can be performed
include getting general information about Parallels Desktop and its configuration settings, modifying
Parallels Desktop preferences, getting a list of users, obtaining statistics, installing a license, and
others.

prictl

The prlctl utility is used to perform administration tasks on virtual machines. The utility supports
a full range of tasks from creating and administering virtual machines to installing Parallels Tools,
getting statistics, and generating problem reports.

The rest of this chapter provides detailed technical information about the commands and options
available with each utility.

In This Chapter

Parallels Desktop Management ... ....oii i e 57
Virtual Maching ManagemeEnt .........uuiiiii e e e 68

Parallels Desktop Management

Parallels Desktop is managed using the pr1srvctl command-line utility, which is installed on the
Mac during the Parallels Desktop installation.

General Syntax

The prlsrvectl command-line utility is used to perform management tasks on Parallels Desktop.
The tasks include getting the Parallels Desktop information, modifying Parallels Desktop
preferences, installing a license, obtaining statistics and problem reports, and some others.
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Syntax
prisrvetl command [options] [-l,--login user[:passwd]@server] [-v, --verbose number]
Parameters
Name Description
command The name of the command to execute.
options Command options. See individual commands for available options.
-1, --login Connect to a remote Parallels Desktop. If this parameter is omitted, the
command will be executed on the local machine.
user Name of the user on the remote Mac.
passwd The user password. If the password is omitted, you will be prompted to
enter it.
server The remote Mac IP address or hostname.
-v, --verbose number Show verbose output. The greater the number, the more verbose
output will be produced.
Remarks

To display help, enter prlsrvctl on the command line without any parameters.

prisrvctl info

Displays the host computer and Parallels Desktop configuration information.

Syntax

prisrvctl info
Remarks

The information returned by the info command includes the following:

» Host machine name.

« Parallels Desktop version number.

« Host operating system type and version.

e The default virtual machine directory name and path.

« Parallels Desktop memory limits.

« Parallels Desktop minimum allowable security level.

« The default backup directory name and path for virtual machines.

« Parallels Desktop license information.

58



Parallels Desktop Command Line Interface

« Host machine hardware configuration information.

« Other miscellaneous info.

Links

General Syntax (p. 57)

prisrvctl install-license

Installs Parallels Desktop license on the host computer.

Syntax

prisrvctl install-license -k, --key key [-n,--name name] [-C,--company name] [--deferred]

Parameters

Name Description

-k, --key key License key.

-n, -—--name name License user name.

-c,-—-company name License company name.

--deferred The license will be activated the next time Parallels Desktop is started. If
a license has already been activated, it should be deactivated first before
using this option. See prisrvctl deactivate-license (p. 59)

Links

General Syntax (p. 57)

prisrvctl deactivate-license

Deactivates Parallels Desktop license.

Syntax

prisrvctl deactivate-license

Links

General Syntax (p. 57)

prisrvctl net

The prlsrvctl net command is used to create and configure virtual networks.
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Subcommands

Name Description

net add Creates a new virtual network

net set Configures the parameters of an existing virtual network.
net del Removes an existing virtual network.

net list List the available virtual networks.

net add

The prlsrvctl net add command is used to create a new virtual network.

Syntax

prisrvctl net add vnetwork id [-i,--ifname irf]

[-m,--mac mac address]

[-t, --type bridged | host-only]
[-d, --description description]

Parameters

Name

Description

vnetwork id

A user-defined name that will identify the new virtual network.

-i,--ifname if

The name of a physical network adapter on the host to which this
virtual network should be bound.

-m, —-mac mac_address

The MAC address of a virtual network adapter on the host to
which this virtual network should be bound.

-t, -—type value

The type of the virtual network to create. Possible values are:

* bridged. A virtual machine connected to this
type of virtual network appears as an independent
computer on the network.

* host_only (default). A virtual machine
connected to this type of virtual network can
access only the host and the virtual machine
connected to the same virtual network.

-d, --description description

A user-defined description of the virtual network.

--ip-scope-start IP address

--ip-scope-end IP address

Sets the start and end IP addresses for the DHCP pool. The
virtual machines connected to the network you are creating will
automatically receive their IP addresses from this DHCP pool.

Links

General Syntax
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net set

The prlsrvctl net set command is used to modify an existing virtual network.

Syntax

prisrvctl net set vnetwork id [-i,--ifname if] [-m,--mac mac address]
[-t, --type bridged | host-only]
[-d, --description description]
[-n, --name new name]

Parameters

Name

Description

vnetwork id

The name of the virtual network to modify.

-i,--ifname if

The name of a physical network adapter on the host to which this
virtual network should be bound.

-m, --mac mac_address

The MAC address of a virtual network adapter on the host to
which this virtual network should be bound.

-t,-—-type

The type of the virtual network to create. Possible values are:

* bridged. A virtual machine connected to this
type of virtual network appears as an independent
computer on the network.

* host_only. A virtual machine connected to this
type of virtual network can access only the host
and the virtual machines connected to the same
virtual network.

-d, --description description

A user-defined description of the virtual network.

-n, -—--name hew_name

A new name for the virtual network. Use this parameter if you
would like to rename the virtual network.

Links

General Syntax

net del

The prlsrvctl net del command is used to delete an existing virtual network.

Syntax

prisrvctl net del vnetwork id
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Parameters

Name Description

vnetwork id The name of the virtual network to delete.
Links

General Syntax

net list

The prlsrvctl net 1list command lists the existing virtual networks.
Syntax
prisrvctl net list

Links

General Syntax

prisrvctl problem-report

Obtains the Parallels Desktop problem report and displays it on the screen.

Syntax

prisrvctl problem-report
Parameters

The command accepts no parameters.

Remarks

The command collects technical data about the Parallels Desktop and displays the report on the
screen (the output can also be piped to a file). The report can then be directed to Parallels technical
support for analysis.

Links

General Syntax (p. 57)
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prisrvctl set

Allows to modify Parallels Desktop preferences.

Syntax

prisrvctl set [--mem-limit auto |size]
[-s, --min-security-level low | normal | high]
[-c, --cep on|off]
[--mng-settings allow |deny]
[ {--device device --assignment host|vm} ]
[--backup-storage user|[ [ipasswd] @server|[iport]]]
[--backup-path path]
[--default-encryption-plugin plugin-id] |

[--reset-default-encryption-plugin]

[--allow-attach-screenshots on|off]

Parameters

Name Description

--mem-limit Sets the upper limit of the memory size that can be
reserved for Parallels Desktop operations. The following
options are available:

e auto -- if this option is used, the memory
size will be calculated automatically.

* size -- user-defined memory size, in
megabytes.

-s,--min-security-level The lowest allowable security level that can be used to
connect to the Parallels Desktop. The following options are
available:

*  low -- plain TCP/IP (no encryption).

*+ normal -- most important data is sent and
received using SSL over TCP/IP (user
credentials during login, guest OS clipboard,
etc.) Other data is sent and received using
plain TCP/IP with no encryption.

* high -- all of the data is sent and received
using SSL.

-c,--cep Enables/disables the participation in the Customer
Experience Program. The following options are available:

* on -- enables CEP.
e off -- disables CEP.

--mng-settings Allows to grant or deny permission to new users to modify
Parallels Desktop preferences. By default, only

63



Parallels Desktop Command Line Interface

administrators of the host OS can modify Parallels Desktop
preferences. When a new Parallels Desktop user profile is
created (this happens when a user logs in to Parallels
Desktop for the first time), he/she will be granted or denied
this privilege based on the default setting. This parameter
allows to set that default setting. Please note that this
parameter only affects new users (the users that will be
created in the future). The profiles of the existing users will
not be modified.

--device device --assignment

Allows to set the assignment mode for the specified VTd
device. The following options are available:

* host --assign the device to host.

« wvm -- assign the device to virtual machines.

--backup-storage

The default backup server where virtual machine backups
will be stored.

user Name of the user on the backup server.

passwd The user password.

server The backup server IP address or hostname.

port Port number. If omitted, the default port number will be

used.

--backup-path path

Name and path of the default directory on the backup
server where virtual machines backups will be stored.

--default-encryption-plugin
plugin-id

Allows to specify which encryption plug-in should be used
by default. An encryption plug-in implements an encryption
algorithm, which is used to encrypt a virtual machine. Use
this option to specify the ID of the plug-in, which should be
used by default.

--reset-default-encryption-plugin

Resets the default encryption plug-in assignment and sets
the built-in plug-in to be used by default.

-—-allow-attach-screenshots

Specifies whether to attach screenshots to problem reports:
* on -- attach screenshots.

« off -- do not attach screenshots.

Links

General Syntax (p. 57)
prisrvctl shutdown
Shuts down Parallels Desktop.

Syntax

prisrvctl shutdown [-f, --force]
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Parameters

Name Description

-f, —--force Specifies whether the shutdown operation should be forced. If one or
more virtual machines are running, clients are connected, or some tasks
are currently in progress, then forcing the shutdown will stop all
processes automatically and will shut down the Parallels Desktop.

Links

General Syntax (p. 57)

prisrvctl statistics

Obtains Parallels Desktop statistics.

Syntax

prisrvctl statistics [-a, --all] [--loop] [--filter name]

Parameters

Name Description

-a, --all This parameter is not currently used.

--loop Subscribes to receive statistics on the periodic basis. Once you execute

the command with this option, the statistics will be displayed in your
console window every time a new set of values is collected. To
unsubscribe, press the Enter key or Ctrl-C in your console window.

--filter name

This parameter is not currently used.

Links

General Syntax (p. 57)

prisrvctl usb

The prlsrvctl usb command is used to permanently assign a USB device to a specific virtual
machine. A permanently assigned USB device will be connected to the virtual machine
automatically on server restart.

Subcommands

Name

Description
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usb list Lists USB devices connected to the host together with the
information about their virtual machine assignments for the current
user.

usb set Permanently assigns a USB device to the specified virtual
machine.

usb del Removes a previously created USB device assignment.

usb list

Lists the USB devices connected to the host.
Syntax

prisrvctl usb list

Options

None.

Returns

A list of USB devices in tabular format with the following columns:

Name — the USB device name.

ID — a string that uniquely identifies the USB devices on the physical server. The ID never changes
even if the device is disconnected from the server and then reconnected again. Please note that if a
device ID is listed in quotes, they are a part of the ID and must be included in other calls that use it

as an input parameter.

VM UUID — a universally unigue ID of the virtual machine to which this USB device is permanently
assigned. If a USB device is not assigned to any virtual machine, this column will be empty.

usb set

Permanently assigns a USB device to the specified virtual machine. A permanently assigned USB
device will be connected to the virtual machine automatically on server restart. The USB device
assignment is performed for the current user only. Other users may create their own USB device
assignments.

Syntax

prisrvctl usb set <usb dev ID> <vm ID|vm name>
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Options

Name

Description

<usb dev ID>

The USB device ID.

<vm_ID|vm name>

The universally unique ID or name of the virtual machine to which
to assign the USB device.

usb del

Deletes a USB device assignment. The USB device assignment is performed on the user level, so if
you remove an assignment, it will only be removed for the current user. Other users may have their
own USB devices assignments, which will not be affected.

Syntax

prisrvctl usb del <usb dev ID>

Options

Name

Description

<usb_dev ID>

The USB device ID.

prisrvctl user list

Displays the list of Parallels Desktop users.

Syntax

prisrvctl user list [-0, --output name[, name...]]

Parameters

Name Description

-0, --output name Names of the fields to include in the output. The following fields are

available:
* name -- User name.

* mng_settings -- Indicates whether the user is
allowed to modify Parallels Desktop preferences.

* def vm home -- The user default virtual machine
folder.

The fields must be specified using the lower case letters.
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See Also

prlsrvctl user set

Links

General Syntax (p. 57)

Virtual Machine Management

Parallels virtual machines can be managed using the pr1ctl command-line utility, which is
installed on a Mac during the Parallels Desktop installation.

General Syntax

The prlctl utility is used to perform administration tasks on virtual machines. The utility supports
a full range of tasks from creating and administering virtual machines to getting statistics and
generating problem reports.

Syntax

prictl command ID|name [options] [-v, =--verbose number]

Parameters

Name Description

command The name of the command to execute (see the table below for the
complete list of commands).

ID The ID of the virtual machine on which to perform the operation. To
obtain the list of the available virtual machines, use the prictl
list command (p. 79).

name The name of the virtual machine on which to perform the operation.
To obtain the list of the available virtual machines, use the prictl
list command (p. 79).

options Command options. See individual commands for available options.

-v, --verbose number Show verbose output. The greater the number, the more verbose
output will be produced.

Remarks

To display help, enter pr1ctl without any parameters.
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prictl backup

Backs up a virtual machine.

Syntax

prictl backup vm id|vm name [-f,--full] [-i,--incremental]
[-s, --storage user|[:passwd]@server|[iport]]
[--description desc]

Parameters

Name Description

vm_id |vm_name

The UUID or the name of the virtual machine to back up.

-s,——storage

This option is used to specify the backup server connection and login
parameters. If this option is omitted, the backup will be saved on the default
backup server. The default backup server can be configured using the
prlsrvctl set command (p. 63).

user The name of the user on a remote backup server.

passwd The user password. If omitted, the user will be prompted to enter a
password.

server Server hostname or IP address.

port Port number. If omitted, the default port number will be used.

--description desc

Backup description.

-f,-—-full

Create a full backup of the virtual machine. A full backup contains all virtual
machine data.

-i,--incremental

Create an incremental backup of the virtual machine. An incremental
backup contains only the files changed since the previous full or incremental
backup. This is the default backup type.

Links

General Syntax

prictl backup-delete

Deletes a virtual machine backup.

Syntax

prictl backup-delete { {vn id|vm name} | -t,--tag backup id}

[-s, --storage user|[ [:passwd]@server[:port] ]
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Parameters

Name

Description

vm_id |vm_name

The UUID or the name of the virtual machine. With this option, the
command will delete all backups of the specified virtual machine. To delete
a specific backup, you need to additionally specify its ID using the —--tag
option (described below).

-t, -—tag backup_id

The ID of the backup to delete.

-s,-—-storage

The backup server connection and login parameters. If this option is
omitted, the backups will be searched for on the default backup server.
The default backup server can be configured using the prlsrvctl set
command (p. 63).

user The name of the backup server user.

passwd The user password.

server Backup server hostname or IP address.

port Port number. If this option is omitted, the default port will be used.
Links

General Syntax

prictl backup-list

Lists the available backups for the specified virtual machine.

Syntax

prictl backup-list [vm id|vm name] [-f,--full]

Parameters

[-s, --storage user|[ipasswd]@server[:port]]

Name

Description

vm_id | vm_name

The UUID or the name of the virtual machine for which to list the available
backups.

-f, --full

Display full backup information.

-s,-—-storage

Backup server connection and login parameters. If this option is omitted, the
backups will be searched for on the default backup server. The default
backup server can be configured using the prlsrvctl set command (p.
63).

--localvms List only the backups of the virtual machines that were residing on the local
server .
user The name of the backup server user.
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passwd The user password.

server Backup server hostname or IP address.

port Port number. If omitted, the default port is used.
Links

General Syntax

prictl capture

Captures the screen of a virtual machine desktop and saves it to a file on the client machine. The
data is saved in the Portable Network Graphics (PNG) format.

Syntax

prictl capture ID|name --file name

Parameters

Name Description

ID The virtual machine ID.

name The virtual machine name.

--file name Name and path of the file to which the image should be saved. You should
include the file extension (.png) or the file will be saved without one.

Links

General Syntax

prictl change-passwd

Changes the encryption password for the specified virtual machine.

Syntax

prictl change-passwd ID|name
Parameters

Name Description

ID Virtual machine ID.

name Virtual machine name.
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Remarks

The command can be used to change the password that was used to encrypt a virtual machine. A
user will be asked to enter the current and the new password.

The virtual machine must be currently encrypted for this command to work. If you would like to
encrypt an unencrypted virtual machine, use the encrypt command (p. 76).

Links

General Syntax

prictl convert

This command is used to convert third-party virtual machines and disks to Parallels virtual
machines and disks. The following third-party virtual machines and disks are supported:

« Microsoft Hyper-V
« Microsoft Virtual PC

« Virtual Box

 VMware

Syntax

prictl convert <path> [--dst <path>] [--force]

Options

Name Description

<path> Full path to the third-party virtual machine's configuration file on the local server.

--dst=<path> Set the destination directory for the resulting virtual machine and its configuration
file. If omitted, the default directory (/var/parallels)is used.

--force Convert the third-party virtual machine even if its guest OS cannot be identified.

prictl clone

Creates an exact copy of the specified virtual machine.

Syntax

prictl clone ID|name --name new name [--template] [--dst path] [--changesid]
[--linked] [--detach-external-hdd yes|no]
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Parameters

Name Description

ID ID of the virtual machine to clone

name Name of the virtual machine to clone.

--name new_name Name to be assigned to the new virtual machine.

--template Create a virtual machine template instead of a real virtual
machine. Templates are used as a basis for creating new virtual
machines.

--dst path Name and path of the new virtual machine directory. If this
parameter is omitted, the new virtual machine will be created in
the default directory.

--changesid Generate a new Windows security identifier (SID) for a
Windows-based virtual machine. For this parameter to work,
Parallels Tools must be installed in the virtual machine.

--linked Create a linked virtual machine.

--detach-external-hdd yes|no |Ifsetto no, hard disks located outside a source virtual machine
are not removed from the configuration of the resulting clone.
Setting the parameter to yes removes outside hard disks from
the configuration.

Note: Outside hard disks are not copied to the
cloned virtual machine.

Links

General Syntax

prictl create

Creates a new virtual machine. A virtual machine can be created from scratch or from a virtual
machine template. When created from scratch, the target operating system type or version must
be specified. To create a virtual machine from a template, the template name must be passed to
the command.

Syntax

prictl create name {--ostype name|--distribution {name|list}} [--location path]

prictl create name --ostemplate name [--location path]

Parameters

Name Description

name User-defined new virtual machine name. If the name consists of two

or more words separated by spaces, it must be enclosed in quotes.
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-0, —--ostype name The name of the family of the operating system that will be installed in
the virtual machine. Select from one of the following:

e windows

e linux

* macos
e feebsd
* o0s2

e msdos

e netware

e solaris

« other (specify this option if the operating system you are
planning to install is not listed above).
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-d, --distribution
name|list

The operating system version that you are planning to install in the
virtual machine.

To display the list of known operating systems, supply the 1ist
value instead of the OS name.

Or supply one of the following values (grouped by family):
Windows

e win-311

e win-95

e win-98

e win-me

e win-nt

e win-2000
e win-xp

e win-2003
e win-vista
e win-2008
e win-7

- win (specify this option if the Windows OS version you
are using is not listed above).

Linux

e rhel
e rhel3
* suse

¢ debian

« fedora-core (specify this option for all Fedora Core
distributions except for Fedora Core 5).

e fc-5

e ubuntu

¢ mandriva
¢ centos

¢ redhat

M opensuse

Mac OS

e macos-10.4
e macos-10.5

e snowleopard

FreeBSD

e freebsd-4
¢ freebsd-5
e freebsd-6
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--ostemplate name The name of the virtual machine template from which to create the
new virtual machine. Use the prlctl list --template
command to obtain the list of the available templates.

--location path Name and path of the directory where to store the new virtual
machine files. If this parameter is omitted, the files will be crated in
the default virtual machine directory.

Remarks

When creating a virtual machine from scratch, you may specify the operating system family or
version. If an operating system version is specified using the --distribution parameter, the
virtual machine will be configured for that operating system. If an operating system family is
specified using the --ostype parameter, the virtual machine will be configured for the default
version of this OS family. The default versions are determined internally by Parallels and are kept in
sync with other Parallels management tools such as Parallels Management Console. The best way
to find out the default versions used in your Parallels installation is by creating a sample virtual
machine.

Links

General Syntax

prictl delete
Deletes a virtual machine from the <host computer>. The command removes a virtual machine

from the Parallels Service registry and permanently deletes all its files from the host. Once
completed, this operation cannot be reversed.

Syntax

prictl delete 1D|name

Parameters

Name Description

ID The ID of the virtual machine to delete.

name The name of the virtual machine to delete.

Links

General Syntax

prictl encrypt, decrypt

Encrypt and decrypt a virtual machine.
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Syntax

prictl encrypt 1ID|name [--dry-run]
prictl decrypt 1ID|name [--dry-run]

Parameters

Name Description

ID The ID of the virtual machine to encrypt or decrypt.

name The name of the virtual machine to encrypt or decrypt.

--dry-run Allows to run the encryption or decryption operation using a simulation.
Use this option to verify that the operation can be performed and that
there are no current limitations with the host computer or the virtual
machine that can make the operation invalid. For example, if you don't
have enough space on the host computer, the simulated run will inform
you of this, so you can correct it before running the actual operation.

Remarks

The encrypt command will encrypt the specified virtual machine and all its data. A user will be
prompted to enter an encryption password after the command is executed from the command line.

The decrypt command will decrypt the specified virtual machine. A user will have to enter a
password that was selected when the virtual machine was encrypted.

The encryption password can be modified for an encrypted virtual machine using the change-
passwd command (p. 71).

Links

General Syntax

prictl enter

Creates a command prompt channel to a virtual machine. By using this command, you can create
a command prompt channel and execute commands in a virtual machine. Parallels Tools must be
installed in a virtual machine to use this utility.

Syntax

prictl enter exec v id|vm name

Parameters

Name Description

vm_id |vm_name The UUID or the name of the virtual machine.
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Links

General Syntax

prictl exec

Executes a command inside a virtual machine. Parallels Tools must be installed in a virtual machine
to use this utility. Commands in Linux guests are invoked with bash -c.

Syntax

prictl exec v _id|vm name command

Parameters

Name Description

vm_id |vm_name The UUID or the name of the virtual machine.
command A command to execute.

Links

General Syntax

prictl installtools

Installs Parallels Tools in the specified virtual machine.

Syntax

prictl installtools 1D|name

Parameters

Name Description

ID The ID of the target virtual machine.
name The name of the target virtual machine.
Notes

To use this command, the target virtual machine must be running.
Links
General Syntax
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prictl list

Obtains a list of virtual machines on the host computer. The command allows to obtain a summary

list containing only the virtual machine ID, name, and status, or to obtain a detailed information

about a specific or all virtual machines.

Syntax

prictl list [--all] [--template] [--no-header]
[-0, =--output name[, name...]] [=S, ==soOrt name|-name]

prictl list --info [ID|name]

Parameters
Name Description
-a, --all List all, running, stopped, suspended, and paused virtual machines. If this

and the rest of the parameters are omitted, only the running virtual machines
will be displayed.

-t, ——template

List the available virtual machine templates. The real virtual machines will not
be included in the output.

--no-header

Do not display column headers.

-0, ——-output name

Display one (or any combination) of the following fields:

e uuid -- Virtual machine ID.

e name -- Virtual machine name.

s status --Virtual machine status (running, stopped, etc.).

The above fields can be combined in a single command using comma
separator (e.g. uuid, name). The excluded fields will not be displayed. The
field names must be typed in lower case.

-s, ——-sort name

Sort the virtual machine list by the specified parameter in ascending order.

-i, --info

Display detailed information about a virtual machine.

ID

The ID of the virtual machine for which to display the detailed information. If
not specified, the information will be displayed for all registered virtual
machines.

name

The name of the virtual machine for which to display the detailed
information. If not specified, the information will be displayed for all
registered virtual machines.

Links

General Syntax
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prictl pause, suspend, resume

Pause, suspend, and resume a virtual machine.

Syntax

prictl pause 71D|name
prictl suspend 1D|name
prictl resume 1D|name

Parameters

Name Description

ID The ID of the virtual machine to pause, suspend, or resume.
name The name of the virtual machine to pause, suspend, or resume.
Remarks

The pause command pauses a virtual machine. To continue the virtual machine operation, use
the prlctl start command (p. 98).

The suspend command suspends the virtual machine operation. When a running virtual machine

is suspended, the state of the virtual machine processes is saved to a file on the host. After that,
the machine is stopped. To resume the machine, use the resume command.

Links

General Syntax

prictl problem-report

Obtains a problem report for the specified virtual machine and displays it on the screen.

Syntax

prictl problem-report ID|name <-d,--dump|-s, --send [--proxy

[user|:password] @proxyhost[:port]]] [=-nO=-proxy]>

Parameters

Name Description

ID The ID of the virtual machine for which to obtain the problem
report.

name The name of the virtual machine for which to obtain the report. If
the name consists of separate words, it must be enclosed in
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quotes.

-d, --dump Collect technical data about a virtual machine and display it on
the screen. You can also pipe the output to a file and then send it
to the Parallels technical support to analyze your problem.

-s, —-send Send the generated problem report to the Parallels technical
support.
——proxy Use the specified information to send the generated report

user:password@proxyhost:port |through a proxy server, if you use one to connect to the Internet.

~~NO-pProxy Do not use a proxy server to send the generated report. This is
the default behavior, so you can omit this parameter.

Links

General Syntax

prictl register, unregister
The register command is used to register a virtual machine with Parallels Service.

The unregister command removes a virtual machine from the Parallels Service registry.

Syntax

prictl register path
prictl unregister 1D|name

Parameters

Name Description

path An absolute path to the virtual machine directory.

ID| name The ID or the name of the virtual machine to remove from the Parallels
Service registry.

Remarks

Use the register command when you have a virtual machine on the host that doesn't show up
in the list of the virtual machines registered with the Parallels Service. This can be a machine that
was previously removed from the registry or a machine that was manually copied from another
location.

The unregister command removes a virtual machine from the Parallels Service registry but does
not delete the virtual machine files from the host. You can re-register such a machine with the
Parallels Service later using the register command.
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Links

General Syntax

prictl restore

Restores a virtual machine from a backup.

Syntax

prictl restore { {vn id|vm name}

| -t,--tag backup id}

[-s, --storage user|[ [:passwd]@server[:port] ]

[-n,

Parameters

--name new name] [--dst path]

Name

Description

vm_id |vm_name

The UUID or the name of the virtual machine. If this option is specified, the
command will restore it from the latest available backup. To restore a virtual
machine from a specific backup, omit this option and specify the backup ID
using the —-tag option (described below).

-t, --tag backup_id

The backup ID from which to restore a virtual machine.

-s,——storage

The backup server connection and login parameters. If this option is
omitted, the backups will be searched for on the default backup server. The
default backup server can be configured using the prlsrvctl set
command (p. 63).

user The name of the backup server user.

passwd The user password.

server The backup server hostname or IP address.

port Port number. If omitted, the default port will be used.

-n, -—--—-name new_name

A new name to assign to the restored virtual machine. If omitted, the virtual
machine will be restored with the original name.

--dst Restore the virtual machine to the specified directory on the Parallels server.
If you omit this option, the virtual machine will be restored to
/var/parallels/vm_name.

Links

General Syntax

prictl server

Obtains information about the host computer and Parallels the Parallels Desktop installed on it.

Also, allows to shut down the Parallels Desktop.
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Syntax

prictl server shutdown |info

Parameters

Name Description

info Displays the Parallels Desktop information.

shutdown Shuts down Parallels Desktop. If one or more virtual machines are running,
clients are connected, or some tasks are currently in progress then the
shutdown operation will be aborted.

See Also

prlsrvctl info (p. 58)

prlsrvctl shutdown (p. 64)

Links

General Syntax

prictl set

The prlctl set command is used to modify the configuration of a virtual machine and manage
virtual machine devices and shared folders. The following subsections provide technical information
on how to use the command to perform these tasks.

Modifying Virtual Machine Configuration
The prlctl set command can be used to modify virtual machine configuration parameters,

including virtual CPU availability, RAM and video memory size, startup and shutdown options, and
some others.

Syntax

prictl set ID|name [--cpus number] [--memsize number]
[--videosize number] [--description description]
[--autostart on |off |auto] [--autostart-delay number]

[--autostop stop |suspend]
[--start-as-user administrator |owner | useripasswd]
[--tools-autoupdate on | off]
[--userpasswd os user:new pass]
[--asset-id tag]
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Parameters

Name Description

ID Target virtual machine ID.
name Target virtual machine name.

--cpus number

Number of virtual CPUs in the virtual machine. If
the host has more than one CPU, this option
allows to set the number of virtual CPUs to be
available in the virtual machine.

--memsize number

The amount of memory (RAM) available to the
virtual machine, in megabytes.

--videosize number

The amount of video memory available to the
virtual machine graphics card.

—--description VM description

Short description of the virtual machine.

—-—autostart on|off|auto

Defines the virtual machine start-up options:

+ on -- the virtual machine is started
automatically on the Parallels Service
startup.

« off -- the autostart is off. This is the
default virtual machine start-up mode.

 auto -- resume the virtual machine
state prior to the Parallels Service
shutdown.

If you set this option to on or auto, you must
additionally specify the --start-as-user
option (see below).

-—autostart-delay number

Sets the time delay used during the virtual
machine automatic startup.

-—autostop stop|suspend

Sets the automatic shutdown mode for the
specified virtual machine:

e stop -- the virtual machine is stopped
when you shut down the Parallels
Service.

e suspend -- the virtual machine is
suspended when the Parallels Service is
shut down.

—-—-start-as-user
administrator|owner|user:passwd

Specifies the account to use to autostart the
virtual machine:

e administrator -- start the virtual
machine as the administrator of the host
operating system.

 owner -- start the virtual machine as
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the virtual machine owner.

e user:passwd -- start the virtual
machine as the specified user.

--tools-autoupdate on|off Turns on/off automatic updating of Parallels
Tools in the guest operating system. If this option
is set to ON, Parallels Tools updates will be
performed automatically every time an update is
available for your Parallels Desktop. If this option
is set to OFF, no automatic Parallels Tools
updates will be performed, so that you can do it
manually at a convenient time.

--userpasswd 0s_user:new_pass Resets the password for the specified user of the
guest OS running in a virtual machine. The
parameters are:

os_user -- guest OS user name.

new_pass -- Nnew password.

--asset-id ID Sets an asset ID (aka asset tag) in the virtual
machine BIOS. Asset IDs are used for computer
identification and inventory purposes.

Links

General Syntax

Managing Virtual Devices

The prlctl set command allows to add virtual devices to a virtual machine and to modify and
delete existing virtual devices.

General Syntax

prictl set 7D| V4 name --device-add dev type options
prictl set 1D| VM name --device-set name options
prictl set 1D| v name --device-del name

Parameters

Name Description

ID The virtual machine ID.

VM name The virtual machine name.
--device-add dev type options Adds a virtual device to the specified virtual

machine.

The dev_type parameter specifies the virtual
device type (hdd, cdrom, £dd, net, etc.).

The options parameters specifies device-type
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specific options.

--device-set name options Modifies the configuration of an existing virtual
device in the specified virtual machine.

The name parameter specifies the virtual device
name.

The options parameters specifies device-type
specific options.

--device-del name Deletes a virtual device from the virtual machine.
The name parameter specifies the name of the
virtual device to delete.

Remarks

All device-related parameters can be subdivided into the following categories:

» Hard disk drives (p. 86)

»  Optical disk drives (p. 88)
« Network cards (p. 90)

+ Floppy disk drives (p. 90)
« USB devices (p. 94)

« Serial ports (p. 92)

« Parallel ports (p. 93)

« Sound cards (p. 94)

Each group of parameters is explained in the following subsections in detalil.

Notes
All operations on virtual machine devices (adding, modifying, or removing a device) must be

performed on a stopped virtual machine. An attempt to perform any of these operations on a
running virtual machine will result in error.

Hard Disk Drive Management Parameters

This group of parameters is used to add and configure virtual hard disks in a virtual machine.

Syntax

prictl set 1ID| VM name --device-add hdd [--image name]
[--type expand |plain] [--size number] [--split]
[--iface ide |scsi] [--position number]

[--enable | --disable]

prictl set 1D| VM name --device-add hdd --device name
[--iface ide|scsi] [--position number]
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[--enable | --disable]

prictl set 1D| VM name --device-set hddN [--image name]
[--type expand |plain] [--size number] [--split]
[--iface ide|scsi] [--position number]
[--enable | --disable ]

prictl set 1D| V¥ name --device-set hddN --device name
[--iface ide|scsi] [--position number]
[--enable | --disable]

Parameters

Name Description

ID The virtual machine ID.

VM _name The virtual machine name.

--device-add Adds a virtual hard disk drive to the virtual machine.
You can connect up to four IDE devices and up to seven SCSI devices
to a virtual machine. This includes hard disks and optical disk drives.

--device-set Modifies the parameters of an existing virtual hard disk.

hdd Specifies the type of the virtual device to add to the virtual machine (in
this instance, a virtual hard disk).

hddn The name of the virtual hard disk to modify. Virtual hard disks are named

using the hddn format where N is the drive index number starting from O
(e.9. hdd0, hdd1). To obtain the list of disk names, use the prictl
1ist command with the --info option.

--image name

This options is used to create a virtual hard disk using an
image file. You have an option of creating a new image file
or to use an existing image.

« To use an existing image file, specify its name and path
using the name parameter.

« To create a new image file, omit the —--image
parameter. New image files are created in the virtual
machine directory and are automatically named using
the harddiskN.hdd format, where N is the disk index
number (€.g. harddisk0.hdd, harddiskl.hdd).

--device name This option is used to create a virtual hard disk based on a boot camp
partition (Mac hosts). The name parameter must contain the boot camp
partition name.

--type expand|plain For image file based virtual disk drives, specified the disk type:

» expand -- expanding disk. The image file is small initially and
grows in size as you add data to it. This is the default virtual
disk type.

* plain -- plain disk. The image file has a fixed size from the
moment it is created (i.e the space is allocated for the drive
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fully). Plain disks perform faster than expanding disks.

--size number The size of the virtual hard disk, in megabytes. The default size is 32,000
MB.
--split Splits the hard disk image file into 2 GB pieces. You should split a virtual

disk if it is stored on a file system that cannot support files larger than 2
GB (e.g. FAT16).

--iface ide|scsi Interface type:
e ide -- IDE drive.
e scsi - SCSI drive (default).

--position number The SCSI or IDE device identifier to be used for the virtual disk. The
allowed ID ranges are the following:

« for IDE devices: 0:0,0:1,1:0,1:1;
« for SCSl device: 0:0,1:0,2:0,3:0,4:0,5:0, 6:0.

You can use one of the following formats for specifying IDs: ID: bus,
ID-bus, ID. For example, if you specify 3:0 (or 3-0 or 3) as number for
a SCSI drive, the guest OS will see the drive as having ID 3 on SCSI bus
0.

—--enable Enables the specified virtual disk drive. All newly added disk drives are
enabled by default (provided the —--disable option is omitted).

--disable Disables the specified virtual disk drive. The disk drive itself is not
removed from the virtual machine configuration.

Links

General Syntax, Virtual Device Management (p. 85)

Optical Disk Drive Management Parameters

This group of parameters is used to add and configure virtual optical disk drives, such as DVD or
CD drives.

Syntax

prictl set 1D| VM name --device-add cdrom --image image name
[--iface ide|scsi] [--position number]
[--enable | --disable] [--connect|--disconnect]

prictl set 7D| VM name --device-add cdrom --device device name
[--iface ide|scsi] [--position number]
[--enable | --disable] [--connect|--disconnect]

prictl set ID| VM name --device-set cdromN
{--device name|--image name} [--iface ide|scsi]
[--position number] [--enable | --disable ]
[--connect | --disconnect]
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Parameters

Name Description

ID The virtual machine ID.
name The virtual machine name.

--device-add

Adds a DVD/CD drive to the virtual machine. You can connect up to four
IDE devices and up to seven SCSI devices to a virtual machine. This
includes virtual hard disks and DVD/CD drives.

--device-set

Modifies the parameters of an existing virtual optical disk.

cdrom

Specifies the virtual device type (in this instance, a CD or DVD drive).

cdromN

The name of the DVD/CD drive to modify. The N postfix indicates the
drive index number. To obtain the list of the available drives, use the
prlctl 1list command with the --info option.

--device name

The name of the physical optical disk to connect to the virtual machine.

--image name

The name of an existing disk image file to mount in the virtual machine.
Currently, the following image file formats are supported: . iso, .cue,
.ccd, and .dmg. The image must not be compressed and/or
encrypted.

--iface ide|scsi

Interface type:
e ide -- IDE disk.
+ scsi -- SCSI disk (default).

--position number

The SCSI or IDE device identifier to be used for the DVD/CD drive. The
allowed ID ranges are the following:

« for IDE devices: 0:0,0:1,1:0,1:1;
« for SCSl device: 0:0,1:0,2:0,3:0,4:0,5:0, 6:0.

You can use one of the following formats for specifying IDs: ID: bus,
ID-bus, ID. For example, if you specify 3:0 (or 3-0 or 3) as number for
a SCSI drive, the guest OS will see the drive as having ID 3 on SCSI bus
0.

--enable Enables the specified DVD/CD drive. All newly added drives are enabled
by default (provided the --disable option is omitted).

--disable Disables the specified optical disk drive. The disk drive itself is not
removed from the virtual machine configuration.

—--connect Automatically connect the specified optical disk drive during the virtual
machine startup process.

--disconnect Do not automatically connect the specified optical disk drive during the
virtual machine startup process.

Links

General Syntax, Virtual Device Management (p. 85)
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Floppy Disk Drive Management Parameters

This group of parameters is used to add floppy disk drives to a virtual machine and to modify

existing virtual floppy disk drives.

Syntax

prictl set 7D| V4 name --device-add fdd [--device name]
[--enable | --disable] [--connect | --disconnect]

prictl set ID| VM name --device-set fdd [--device name]
[--enable | --disable] [--connect | --disconnect]

Parameters
Name Description
ID The virtual machine ID.
VM name The virtual machine name.
Specifies the type of the virtual device to add or modify (in this instance, a
fdd floppy disk drive).

--device-add

Adds a new floppy disk drive to the virtual machine. You can connect only
one floppy disk drive to a virtual machine.

--device-set

Modifies the parameters of an existing virtual floppy disk drive.

--device name

The name of the physical floppy disk drive to connect to the virtual machine.
If this parameter is omitted, a floppy drive image emulating the floppy disk
drive will be created.

--enable Enables the specified floppy disk drive. All newly added floppy drives are
enabled by default (provided the --disable option was omitted during the
drive creation).

--disable Disables the specified floppy disk drive. The drive itself is not removed from
the virtual machine configuration.

—--connect Connect the specified floppy disk drive automatically during the virtual
machine startup process.

--disconnect Use this option if you don't want the specified floppy disk drive automatically

connected to the virtual machine on its start.

--image path

The name and path of an existing floppy disk image file (usually
floppy . £dd) to mount in the virtual machine.

Links

General Syntax, Virtual Device Management (p. 85)

Network Adapter Management Parameters

This group of parameters is used to manage virtual network adapters in a virtual machine.
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Syntax

prictl set 7D| VM name --device-add net --type shared | host|bridged
[--mac addr] [--enable | --disable] [--connect | --disconnect]

prictl set ID| VM name --device-add net --type bridged --iface name

[=-mac addr] [--enable | --disable] [--connect|--disconnect]

prictl set ID| V4 name --device-set netN --type shared | host
[=-mac addr] [--enable | --disable] [--connect | --disconnect]

prictl set ID| V4 name --device-set netN --type bridged
--iface name [--mac addr|auto] [--enable | --disable]
[--connect | --disconnect]

Parameters

Name Description

ID The virtual machine ID.

VM _name The virtual machine name.

--device-add

Adds a new virtual network adapter to the virtual machine.

--device-set

Used to configure an existing virtual network adapter.

net Specifies the virtual device type to add (in this instance, a virtual network
adapter).

netN The name of the virtual network adapter to modify. To obtain the list of the
available adapters, use the prlctl 1list command with the --info
option.

-—type

shared|host|bridged

Sets the networking mode for the virtual network adapter:

» shared -- Shared networking. Select this option if you wish to
enable Network Address Translation (NAT) for the adapter. The
adapter will share the IP address with the host computer when
communicating with external networks.

* host -- Host-only networking. Select this option if you wish the
virtual machine to communicate only with the host computer
and other virtual machines included in the same network.
Access to external networks is not allowed.

* Dbridged -- Bridged networking. The adapter is bound to the
specified physical network adapter. The virtual machine will
appear as a standalone computer on the network.

--iface name

Used with the bridged networking mode (see above). Specifies the name of
the physical network adapter to which the virtual adapter should be bound.

--mac addr

The MAC address to be assigned to the virtual network adapter. If this
option is omitted, the MAC address will be generated automatically.

--mac addr]|auto

Specifies the MAC address to assign to an existing network adapter.
Specify a desired MAC address using the addr parameter value or use the
auto option to re-generate the existing address automatically.
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--enable Enables the virtual network card. All newly created network adapters are
enabled by default (provided the --disable option is omitted).

--disable Disables virtual network adapter. The adapter itself is not removed from the
virtual machine configuration. Please note that a disabled virtual network
adapter can only be enabled in a stopped virtual machine.

--connect Automatically connect the virtual network adapter during the virtual
machine startup process.

--disconnect Do not automatically connect the virtual network adapter during the virtual
machine startup process.

Links

General Syntax, Virtual Device Management (p. 85)

Serial Port Management Parameters

This group of parameters is used to manage serial ports in a virtual machine.

Syntax

prictl set 7D| VM name --device-add serial
{--device name|--output rile|--socket name}
[--enable | --disable] [--connect | --disconnect]

prictl set 1D| V4 name --device-set serialn
{--device name|--output file|--socket name}
[--enable | --disable] [--connect | --disconnect]

Parameters

Name Description

ID The virtual machine ID.

VM _name The virtual machine name.

--device-add Adds a new serial port to the virtual machine. You can connect up to four
serial ports to a virtual machine.

--device-set Modifies the parameters of an existing serial port.

serial Specifies the type of the virtual device to add (in this instance, a serial port).

--device name The name of the physical serial port to which to connect the virtual machine.

--output file The name and path of the output file to which to connect the virtual serial
port.

--socket name The name of the physical socket to which to connect the virtual serial port.

--enable Enables the virtual serial port. All newly added serial ports are enabled by
default (provided the —-disable option is omitted).

--disable Disables the virtual serial port.

—--connect Automatically connect the virtual serial port during the virtual machine
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startup process.

--disconnect

Do not automatically connect the virtual serial port during the virtual machine
startup process.

Links

General Syntax, Virtual Device Management (p. 85)

Parallel Port Management Parameters

This group of parameters is used to manage parallel port in a virtual machine.

Syntax

prictl set ID| VM name --device-add parallel
{--device name|--output file name}
[--enable | --disable] [--connect | --disconnect]

prictl set ID| VM name --device-set parallelN
{--device name|--output file name}
[--enable | --disable] [--connect | --disconnect]

Parameters

Name Description

ID The virtual machine ID.
name The virtual machine name.

-—-device-add

Adds a new parallel port to the virtual machine. You can connect
up to three parallel ports to a virtual machine.

--device-set

Modifies the parameters of an existing virtual parallel port.

parallel Specified the type of the virtual device to add (in this instance, a
virtual parallel port).
parallelN The name of the parallel port to modify. To obtain the list of ports,

use the prictl 1ist command with the --info option.

--device name

The name of the physical parallel port to which to connect the
virtual parallel port.

--output file name

The name of the output file to which to connect the virtual parallel
port.

-—-enable

Enables the specified parallel port. All newly added parallel ports
are enabled by default (provided the --disable option was
omitted during the port creation).

--disable

Disable the specified virtual parallel port. The port itself is not
removed from the virtual machine configuration.

—-—-connect

Automatically connect the specified virtual parallel port during the
virtual machine startup process.

--disconnect

Do not automatically connect the specified virtual parallel port
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| during the virtual machine startup process.

Links

General Syntax, Virtual Device Management (p. 85)

USB Controller Management Parameters

This group of parameters is used to manage the USB controller in a virtual machine.

Syntax

prictl set 1D| VM name --device-add usb [--enable |--disable]

Parameters

Name Description

ID The virtual machine ID.

VM _name The virtual machine name.

usb The type of the virtual device to add to the virtual machine (in this instance, a
USB device).

--enable Enables the USB controller. This is the default option.

--disable Disables the USB controller.

Links

General Syntax, Virtual Device Management (p. 85)

Sound Device Management Parameters

This group of parameters is used to manage sound devices in a virtual machine.

Syntax

prictl set ID| VM name --device-add sound --output name

[--enable | --disable] [--connect | --disconnect]

prictl set ID| VM name --device-set sound --output name

[--enable | --disable] [--connect | --disconnect]

Parameters

Name Description

ID The virtual machine ID.

VM name The virtual machine name.

sound The type of the virtual device to add to the virtual machine (in this instance,
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a sound device).

--output name The name of a physical output device to which to connect the virtual sound
device.
-—input name The name of the physical input device to which to connect the virtual

sound device.

--enable Enables the specified sound device. All newly added sound devices are
enabled by default (provided the --disable option is omitted).

--disable Disables the specified virtual sound device.

—--connect Automatically connect the sound device during the virtual machine startup
process.

—--disconnect Do not automatically connect the sound device during the virtual machine

startup process.

Links

General Syntax, Virtual Device Management (p. 85)

Removing Devices from Virtual Machine

The --device-del option is used to remove virtual devices from a virtual machine.

Syntax

prictl set 7D|name --device-del name

Parameters

Name Description

--device-del name The name of the virtual device to delete from the virtual machine. To obtain
the list of virtual devices, use the prlctl 1list command with the —-
info option.

Links

General Syntax, Virtual Device Management (p. 85)

Managing Shared Folders

The prlctl set command can be used to add shared folders to a virtual machine and to modify
and delete existing shared folders.

Syntax

prictl set 1D| V4 name --shf-host-add name --path path
[-=-mode ro|rw]
[--shf-description txt]
[--enable | --disable ]
prictl set ID| VM name --shf-host-set name [--mode ro|rw]
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prictl set 7D|VM name --shf-host on|off

[--path path]
[--shf-description txt]
[--enable | --disable]

prictl set 7D| VM name --shf-host-del name
prictl set 1ID| Vv name --shf-guest on | off
prictl set 1D| VM name --shf-guest-automount on | off

Parameters

Name Description

ID The virtual machine ID.
VM _name The virtual machine name.

--shf-host-add

Shares the specified folder on the host computer with the
virtual machine.

--shf-host-set

Modifies the settings of an existing shared folder.

--shf-host on|off

Turns the host folder sharing on or off.

--shf-host-del

Removes the specified shared folder from the shared
folder list.

--shf-guest on|off

Turns the guest folder sharing on or off.

--shf-guest-automount on|off

Mounts or unmounts virtual disks on the host computer.

name User-defined shared folder name.

--path Name and path of a folder on the host computer to share
with the specified virtual machine.

--mode Sharing mode:

* ro -- read-only

« rw -- read and write

--shf-description

User-defined shared folder description.

--enable Enable the shared folder.
--disable Disable the shared folder.
Links

General Syntax

prictl snapshot

Takes a snapshot of a running virtual machine.

Syntax

prictl snapshot ID|name [-n,--name name] [-d,--description desc]
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Parameters

Name Description

ID The virtual machine ID.

name The virtual machine name.

-n, --name name User-defined snapshot name.

-d, --description desc User-defined snapshot description.
Links

General Syntax

prictl snapshot-delete

Deletes a virtual machine snapshot.

Syntax

prictl snapshot-delete ID|name -i,--id snapshot id
Parameters

Name Description

ID The virtual machine ID.

name The virtual machine name.

-i, --id snapshot id The ID of the snapshot to delete.

Note: If the specified snapshot has child snapshots that were derived from it, they will not be deleted.

Links

General Syntax

prictl snapshot-list

Displays a list of snapshots of the specified virtual machine.

Syntax

prictl snapshot-list 1D|name [-t,--tree] [-i,--id snapshot id]
Parameters

Name Description
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ID The virtual machine ID.
name The virtual machine name.
-t, --tree Displays the snapshot list as a tree. The default display format is

tabular with Parent Snapshot ID and Snapshot ID as columns.

-i, --id snapshot_id The ID of the snapshot to use as a root. If this parameter is
omitted, the entire snapshot tree will be displayed.

Links

General Syntax

prictl snapshot-switch

Reverts the specified virtual machine to the specified snapshot.

Syntax

prictl snapshot-switch ID|name -i,--id snapshot id
Parameters

Name Description

ID The virtual machine ID.

name The virtual machine name.

-i, --id snapshot id The ID of the snapshot to revert to.
Links

General Syntax

prictl start, stop, restart, reset, status

Start, stop, reset, and check the status of a virtual machine.

Syntax

prictl start 7D| name

prictl stop 1D|name [--Kill]
prictl restart 1D| name
prictl reset ID|name

prictl status ID|name

Parameters

Name Description
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ID The ID of the virtual machine to start, stop, restart, reset, or check the
status of.
name The name of the virtual machine to start, stop, restart, reset, or check

the status of.

--kill Perform a 'hard' virtual machine shutdown. If this option is omitted, an
attempt to perform a graceful shutdown will be made.

Remarks

The stop command can perform a 'hard' or a graceful virtual machine shutdown. If the --ki11
parameter is included, the 'hard’ shutdown will be performed. If the parameter is omitted, the
outcome of the graceful shutdown attempt will depend on the following:

» If the Parallels Tools package is installed in a virtual machine, the graceful shutdown will be
performed using its facilities.

« If the Parallels Tools package is not installed, the command will try to perform a graceful
shutdown using ACPI. Depending on the ACPI support availability in the guest operating
system, this may work or not.

The restart command first gracefully shuts down a virtual machine and then starts it again.

The reset command first performs a ‘hard' virtual machine shutdown and then starts it again.

The start command can be used to start a stopped virtual machine or to resume a paused virtual

machine.

Links

General Syntax
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